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Wwise	Unity	Integration



Wwise	Unity	Integration:

Wwise	Unity	Integration	2017.2.1.6524.980
Wwise	Unity	Integration	2017.2.0.6500.947

2017.2
	2017.2

Wwise	Unity	Integration	2017.1.4.6407.845
Wwise	Unity	Integration	2017.1.3.6377.812
Wwise	Unity	Integration	2017.1.2.6361.791
Wwise	Unity	Integration	2017.1.1.6340.770
Wwise	Unity	Integration	2017.1.0.6302.726

2017.1
	2017.1

Wwise	Unity	Integration	2016.2.4.6098.531
Wwise	Unity	Integration	2016.2.3.6077.504
Wwise	Unity	Integration	2016.2.2.6022.430
Wwise	Unity	Integration	2016.2.1.5995.409
Wwise	Unity	Integration	2016.2.1
Wwise	Unity	Integration	2016.2.0
Wwise	Unity	Integration	2016.1.3
Wwise	Unity	Integration	2016.1.2
Wwise	Unity	Integration	2016.1.1
Wwise	Unity	Integration	2016.1
Wwise	Unity	Integration	2015.1.4
Wwise	Unity	Integration	2015.1.3
Wwise	Unity	Integration	2015.1.2
Wwise	Unity	Integration	2015.1.1
Wwise	Unity	Integration	2015.1
Wwise	Unity	Integration	2014.1.6
Wwise	Unity	Integration	2014.1.5
Wwise	Unity	Integration	2014.1.4
Wwise	Unity	Integration	2014.1.3
Wwise	Unity	Integration	2014.1.2
Wwise	Unity	Integration	2014.1.1
Wwise	Unity	Integration	2014.1
Wwise	Unity	Integration	2013.2.9



Wwise	Unity	Integration	2013.2.8
Wwise	Unity	Integration	2013.2.5
Wwise	Unity	Integration	2013.2.4
Wwise	Unity	Integration	2013.1.1
Wwise	Unity	Integration	2013.1



Wwise	Unity	Integration	2017.2.1.6524.980
Wwise	2017.2.1Wwise	SDK

Wwise	SDK:	2017.2.1
UnityUnity	5.55.62017.12017.22017.3	(PersonalPro)

	:	Unity
4

Wwise	Unity	Integration	
Android
iOS
Linux
Mac
PS4
tvOS
Windows
Xbox	One

Unity	2017.3.0f3

UWP	(
Windows	) Unity	2017.3.0p3

Switch Unity	for	Nintendo	Switch	3.1.2	(Unity	5.6.4
with	NintendoSDK	3.5.2)

:

WG-34267:	Wwise_IDs.csAK"Ak"
WG-35301:	EventTimeline AkEventSection

WG-35609:	AkRoomPortal
WG-36086:	AkRoomPortal
WG-36099:	2016.2.4NullReferenceException
WG-36125:	Fixed	compatibility	with	Unity	5.5.
WG-36144:	Fully	specified	System.IO.Path	in	Wwise	C#	script	to
avoid	potential	conflicts.
WG-36219:	Unity	2017.3Wwise	Picker
WG-36356:	Exposed	monitoring	pool	size	and	queue	size	in



AkInitializer	inspector.
WG-36413:	Fixed	crash	when	having	more	than	one	portal	from	one
room	to	the	other.



Wwise	Unity	Integration	2017.2.0.6500.947
Wwise	2017.2.0Wwise	SDKUnity	2017.3

Wwise	SDK:	2017.2.0
UnityUnity	5.55.62017.12017.22017.3	(PersonalPro)

	:	Unity
4

Wwise	Unity	Integration	
Mac
Windows Unity	2017.3.0f3

Android
iOS
Linux
PS4
tvOS
UWP	(
Windows	)
Xbox	One

Unity	2017.2.0f3

Switch Unity	for	Nintendo	Switch	3.1.2	(Unity	5.6.4
with	NintendoSDK	3.5.2)

:

2017.2	

breaking	changes 	2017.2

:

WG-25994:	C#	 UnityAudio	Input	Source 	
WG-27337:	MIDI	 MIDIWwise 	
WG-28541:	AkAk



WG-33501:	SoundBank
WG-34446:	AkCallbackManager



Wwise	Unity	Integration	2017.1.4.6407.845

Wwise	SDK:	2017.1.4
UnityUnity	5.55.62017.12017.2	(PersonalPro)

	:	Unity
4

Wwise	Unity	Integration	
Android
iOS
Linux
Mac
PS4
PS	Vita
tvOS
UWP	(
Windows	)
Windows
Xbox	One

Unity	2017.2.0f3

Switch Unity	for	Nintendo	Switch	3.1.2	(Unity	5.6.4
with	NintendoSDK	3.5.2)

:

WG-35168:	Switch
WG-35383:	WwiseTypesID
WG-35384:	AkAudioListener AkInitializer AkTerminator Awake()

OnEnable()Editor 	WG-35513:	AkGameObj
WG-35958:	Unity	2017.3Unity	2017.3



Wwise	Unity	Integration	2017.1.3.6377.812
Wwise	2017.1.3Wwise	SDKUnity	2017.1

Wwise	SDK:	2017.1.3
UnityUnity	5.55.62017.12017.2	(PersonalPro)

	:	Unity
4

Wwise	Unity	Integration	
Android
iOS
Linux
Mac
PS4
PS	Vita
tvOS
UWP	(	Windows
)
Windows
Xbox	One

Unity2017.2.0f3

Switch Switch	1.0.1	Unity	(Unity	5.5.0p1	with
Nintendo	SDK	1.4.0)

:

WG-34855:	AkSoundEngine.GetCurrentLanguage()
WG-35075:	:	Unity	2017.2Wwise	Launcher



Wwise	Unity	Integration	2017.1.2.6361.791
Wwise	2017.1.2Wwise	SDK

Wwise	SDK:	2017.1.2
Unity:	Unity	2017.1	(PersonalPro)

	:	Unity
4

Wwise	Unity	Integration	
Android
iOS
Linux
Mac
PS4
PS	Vita
tvOS
UWP	(	Windows
)
Windows
Xbox	One

Unity	5.6.1p1

Switch Switch	1.0.1	Unity	(Unity	5.5.0p1	with
Nintendo	SDK	1.4.0)



Wwise	Unity	Integration	2017.1.1.6340.770
Wwise	2017.1.1Wwise	SDKUnity	2017.1

Wwise	SDK:	2017.1.1
Unity:	Unity	2017.1	(PersonalPro)

	:	Unity
4

Wwise	Unity	Integration	
Mac
Windows Unity	2017.1.0f3

Android
iOS
Linux
PS4
PS	Vita
tvOS
UWP	(	Windows
)
Xbox	One

Unity	5.6.1p1

Switch Switch	1.0.1	Unity	(Unity	5.5.0p1	with
Nintendo	SDK	1.4.0)

:

WG-33018:	:	Decode	Banks
WG-33818:	iOSAndroid
WG-34090WSA	Unity	PluginTLS	Allocator	Error
WG-34188:	System.EventHandlerfully	qualified	name)
WG-34205:	UnityEditor.MenuUnityEditor.MenuItemfully
qualified	name)



Wwise	Unity	Integration	2017.1.0.6302.726
Wwise	2017.1.0Wwise	SDKUnity	2017.1

Wwise	SDK:	2017.1.0
Unity:	Unity	2017.1	(PersonalPro)

	:	Unity
4

Wwise	Unity	Integration	
Mac
Windows Unity	2017.1.0f3

Android
iOS
Linux
PS4
PS	Vita
tvOS
UWP	(	Windows
)
Xbox	One

Unity	5.6.1p1

Switch Switch	1.0.1	Unity	(Unity	5.5.0p1	with
Nintendo	SDK	1.4.0)

:

2017.1	

Wii	U
GameObjectUnity	Integration	Extensions Wwise	Installation
and	Migration	Guide
AkCallbackManager	 	2017.1 	

:

https://www.audiokinetic.com/library/edge/?source=InstallGuide&id=integrating_wwise_into_an_unreal_or_unity_project


WG-27479:	 AkInitializer

WG-30791:	WwiseTypes	 WwiseTypes	
WG-31155	 AkMemSettings		 AkChannelConfig	
SoundEngine
WG-31735	GameObject	 Unity	Integration	
WG-32348SoundBanksInfoXML
WG-32657	 foreach	
WG-33303AK_MusicPlaylistSelect
WG-34003:	



Wwise	Unity	Integration	2016.2.4.6098.531
Wwise	2016.2.4Wwise	SDK

Wwise	SDK:	2016.2.4
Unity:	Unity	5.6	(PersonalPro)

	:	Unity
4

Wwise	Unity	Integration	
Android
iOS
Linux
Mac
PS4
PS	Vita
tvOS
Windows
Windows	Store	(
Windows	)
Xbox	One

Unity	5.6.1p1

Switch Switch	1.0.1	Unity	(Unity	5.5.0p1
with	Nintendo	SDK	1.4.0)

:

WG-33395:	



Wwise	Unity	Integration	2016.2.3.6077.504
Wwise	2016.2.3Wwise	SDK

Wwise	SDK:	2016.2.3
Unity:	Unity	5.6	(PersonalPro)

	:	Unity
4

Wwise	Unity	Integration

Android
iOS
Linux
Mac
PS4
PS	Vita
tvOS
Windows
Windows	Store	(	Windows	
)
Xbox	One

Unity	5.6.0f3

Switch Unity	for	Switch	0.6.1
Wii	U Unity	5.4.2f2

:

WG-32536:	Nintendo	Switch

WG-32623:	Android



Wwise	Unity	Integration	2016.2.2.6022.430
Wwise	2016.2.2Wwise	SDK

Wwise	SDK:	2016.2.2
Unity:	Unity	5.5	(PersonalPro)

	:	Unity
4

Wwise	Unity	Integration

Android
iOS
Linux
Mac
PS4
PS	Vita
tvOS
Windows
Windows	Store	(	Windows	
)
Xbox	One

Unity	5.5.0p4

Wii	U Unity	5.4.2f2

:

WG-31862:	enum



Wwise	Unity	Integration	2016.2.1.5995.409
Wwise	2016.2.1Wwise	SDK

Wwise	SDK:	2016.2.1
Unity:	Unity	5.5	(PersonalPro)

	:	Unity
4

Wwise	Unity	Integration

Android
iOS
Linux
Mac
PS4
PS	Vita
tvOS
Windows
Windows	Store	(	Windows	
)
Xbox	One

Unity	5.5.0f3

Wii	U Unity	5.4.2f2

:

WG-32006:	GameObject"Unknown	Game	Object	ID"



Wwise	Unity	Integration	2016.2.1
Wwise	2016.2.1Wwise	SDK

Wwise	SDK:	2016.2.1
Unity:	Unity	5.5	(PersonalPro)

	:	Unity
4

Wwise	Unity	Integration

Android
iOS
Linux
Mac
PS4
PS	Vita
tvOS
Windows
Windows	Store	(	Windows	
)
Xbox	One

Unity	5.5.0f3

Wii	U Unity	5.4.2f2

:

WG-27085:	AuxSends
WG-31127:	AK_MusicSyncUserCue
WG-31650:	SoundEngineAkGameObjFixed
NullReferenceException
WG-31651:	SetObjectPositionAkGameObj
WG-31862:	enum

Unity	case	#861189:	Unity	Windows	StoreLauncher

https://fogbugz.unity3d.com/default.asp?861189_deb0tebbc8rt0vl0


Wwise	Unity	Integration	2016.2.0
Wwise	2016.2.0Wwise	SDK

Wwise	SDK:	2016.2.0
Unity:	Unity	5.4	(PersonalPro)

	:	Unity
4

Wwise	Unity	Integration

Android
iOS
Linux
Mac
PS4
PS	Vita
tvOS
Windows
Windows	Store	(	Windows	
)
Xbox	One

Unity	5.4.1p2

Wii	U Unity	5.2.4f1

Windows	Phone	8.1Windows	Store	8.08.13
Windows	StoreUniversal	Windows	Platform	(UWP)	
Xbox	360	
PS3	

:

WG-30571:	LibraryWwise	Unity	Integration



WG-30960:	AkGameObjUnity
WG-31507:	DurationMediaIDbStreaming



Wwise	Unity	Integration	2016.1.3
Wwise	2016.2.3Wwise	SDK

Wwise	SDK:	2016.1.3
Unity:	Unity	5.4	(PersonalPro)

	:	Integration	Unity	4	Unity	4Wwise
Integration	Unity

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
PS3
PS4
PS	Vita
tvOS
Windows
Windows	Store
Xbox	One

Unity	5.4.0p2

Wii	U Unity	5.2.4f1
Xbox	360 Unity	5.0.1f1



Wwise	Unity	Integration	2016.1.2
Wwise	2016.1.2Wwise	SDKWwise	Unity

Wwise	SDK:	2016.1.2
Unity:	Unity	5.4	(PersonalPro)

	:	Unity
4

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
PS3
PS4
PS	Vita
tvOS
Windows
Windows	Store
Xbox	One

Unity	5.4.0p2

Wii	U Unity	5.2.4f1
Xbox	360 Unity	5.0.1f1

:

WG-30567	Fixed:	WAV

SWIGzipzipSWIG
SWIG
Wwise	2014.1.42016.12015.1.6



2016.1
UnityUnity	5.4Wwise	2016.1.2	Unity	5.4Wwise
2016.1.2



Wwise	Unity	Integration	2016.1.1
Wwise	2016.1.1Wwise	SDK

Wwise	SDK:	2016.1.1
Unity:	Unity	5.3	(PersonalPro)

	:	Unity
4

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
PS3
PS4
PS	Vita
tvOS
Windows
Windows	Store
Xbox	One

Unity	5.3.5p6

Wii	U Unity	5.2.4f1
Xbox	360 Unity	5.0.1f1

:

WG-30021:	SoundBankSoundBank
WG-30228:	Linux
WG-30231:	tvOS
WG-30259:	GC.Collect	 AkGameObj	

:

WG-30128:	VitaSoundBank



WG-30139:	Wii	USoundBank



Wwise	Unity	Integration	2016.1
Wwise	2016.1Wwise	SDK

Wwise	SDK:	2016.1
Unity:	Unity	5.3	(PersonalPro)

	:	Unity
4

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
PS3
PS4
PS	Vita
Windows
Windows	Store
Xbox	One

Unity	5.3.4p3

Wii	U Unity	5.2.4f1
Xbox	360 Unity	5.0.1f1

:

WG-25675	:	WwiseSoundBankWwise	Picker
"Generate	SoundBanks"
WG-27583	Fixed:	UnitySoundBankUnity
SoundBank
WG-28175	:	WwiseGlobal
WG-26011	:	SceneAK	Audio	ListnerDefault	Unity	Audio
Listener



SWIGzipzipSWIG
SWIG
Wwise	2014.1.42016.12015.1.6
2016.1

:

WG-30021:	EditorDecodeBanks
WG-30021:	DecodeBanksSoundBankSoundBank
DecodedBanks
WG-30128:	VitaSoundBank
WG-30139:	WiiUSoundBank



Wwise	Unity	Integration	2015.1.4
Wwise	2016.1Wwise	SDK

Wwise	SDK:	2015.1.4
Unity:	Unity	4.6	ProUnity	5.2	(Personal		Pro)

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
Metro
PS3
PS4
PS	Vita
Windows
Windows	Phone
Xbox	One

Unity	5.2.2p1

Wii	U Unity	4.3.7f1Wii	U2.2.5
Xbox	360 Unity	5.0.1f1

:

WG-28412	:	 AkGameObj	Prefab
WG-28723	:	PS4



Wwise	Unity	Integration	2015.1.3
Wwise	2015.1.3Wwise	SDKUniversal	Windows	Platform

Wwise	SDK:	2015.1.3
Unity:	Unity	4.6	ProUnity	5.2	(Personal		Pro)

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
PS3
PS4
PS	Vita
Windows
Windows	Store	Apps
Xbox	One

Unity	5.2.2p1

Wii	U Unity	4.3.7f1Wii	U2.2.5
Xbox	360 Unity	5.0.1f1

:

Universal	Windows	PlatformWindows	Store	Apps
Windows	Store	Apps	SDK	8.1
Windows	Phone	8.0
Windows	Store	Apps	SDK	8.0

:

WG-25945	:	WwiseUnityWwiseGlobalWwise
Unity
WG-26011	:	SceneAK	Audio	ListnerDefault	Unity	Audio
Listener
WG-28108	:	EditorEditor



WG-28175	:	WwiseGlobal
WG-28479	:	SetupMain	Camera
Setup
WG-28526	:	Unity	EditorGameObjectsSoundEngine



Wwise	Unity	Integration	2015.1.2
Wwise	2016.1Wwise	SDK

Wwise	SDK:	2015.1.2
Unity:	Unity	4.6.5	ProUnity	5.1.2p2	(Personal		Pro)

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
Metro
PS3
PS4
PS	Vita
Windows
Windows	Phone
Xbox	One

Unity	5.2.0f3

Wii	U Unity	4.3.7f1Wii	U2.2.5
Xbox	360 Unity	5.0.1f1

:

WG-27029	:	Unity	GameObject	 AkGameObj

WG-28200	:	Everything(0,	0,	0)GameObject3D
L0



Wwise	Unity	Integration	2015.1.1
Wwise	2015.1.1Wwise	SDK

Wwise	SDK:	2015.1.1
Unity:	Unity	4.6.5	ProUnity	5.1.2p2	(Personal		Pro)

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
Metro
PS3
PS4
PS	Vita
Windows
Windows	Phone
Xbox	One

Unity	5.1.2p2

Wii	U Unity	4.3.7f1Wii	U2.2.5
Xbox	360 Unity	5.0.1f1

:

WG-27977	:	Unity
WG-28030	:	Wii	U/Unity:	Release	RPLTRCNDEBUG
WG-28042	:	Unity:	Wwise
WG-28044	:	Unity:	Wwise
WG-28046	:		 AkInitializer	
WG-28048	:	Wwise	ProfilerGameObject



Wwise	Unity	Integration	2015.1
Wwise	2015.1Wwise	SDK

Wwise	SDK:	2015.1

:

WG-25669:	Wwise	PickerAuto	PopulateMac	Editor

:

WG-27079	Fixed:	WwiseSettings.xml



Wwise	Unity	Integration	2014.1.6
Wwise	2014.1.6Wwise	SDK

Wwise	SDK:	2014.1.6
Unity:	Unity	4.6.5	ProUnity	5.1.2p2	(Personal		Pro)

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
Metro
PS3
PS4
PSVita
Windows
Windows	Phone

Unity	5.0.2p3

Xbox	360 Unity	5.0.1f1
Xbox	One Unity	5.0.2p4

:

WG-27585	Fixed:	Wwise	PickerWwise
WG-27624	Fixed:	(PS3)	SetListenerPostionPS3

Unity:

Xbox	One:	UnitySoundEngine
Unity	4Windows	Store	Apps:	 DllNotFoundException

unity_troubleshooting

:

WG-27585	Fixed:	Wwise	PickerWwise



Wwise	Unity	Integration	2014.1.5
Wwise	2014.1.5Wwise	SDK

Wwise	SDK:	2014.1.5
Unity:	Unity	4.6.5	ProUnity	5.1.2p2	(Personal		Pro)

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
Metro
PS3
PS4
PSVita
Windows
Windows	Phone

Unity	5.0.2p3

Xbox	360 Unity	5.0.1f1
Xbox	One Unity	5.0.2p4

:

WG-25669:	Wwise	PickerAuto	PopulateMac	Editor

Unity:

Xbox	One:	UnitySoundEngine
Unity	4Windows	Store	Apps:	 DllNotFoundException

unity_troubleshooting

:

Android	x86
Windows	Store	AppsScripting	Define	Symbols



:

WG-27108	Fixed:	DestroyUnity
WG-25733	Fixed:	WindowsiOS/Mac
WG-26875	Fixed:	AkMemBankLoader



Wwise	Unity	Integration	2014.1.4
Wwise	2017.1.1Wwise	SDKUnity	2017.1

Wwise	SDK:	2014.1.4
Unity:	Unity	4	ProUnity	5	PersonalPro

:

WG-26780	Fixed:	WwiseUnity
WG-26837	Fixed:	AkBankManager

:

WG-25669:	Wwise	PickerAuto	PopulateMac	Editor
WG-25733:	WindowsiOS/Mac

:

Windows	Phone	8.1Metro
Unity	5Wwise	Unity	IntegrationPlugin	Importer	API

<UNITY_PROJECT_ROOT>/Assets/Plugins

--	: 	Unity	4Unity	5:

1.	
2.	 Unity	4Unity	5Unity	--	-#	Unity	52014.1.4

Unity
3.	 "Start"
4.	
5.	 Unity	5Wwise	Unity	Integration



Wwise	Unity	Integration	2014.1.3
Wwise	2014.1.3Wwise	SDK

Wwise	SDK:	2014.1.3

:

WG-25669:	Wwise	PickerAuto	PopulateMac	Editor
WG-25733:	WindowsiOS/Mac



Wwise	Unity	Integration	2014.1.2
Wwise	2014.1.2Wwise	SDK

Wwise	SDK:	2014.1.2
Unity	Editor	(October	XDK)	Wwise	SDK	(November	XDK)	XDK
Xbox	One

:

WG-26305	Fixed:	Null64-bit
WG-26337	Fixed:	Mac	64-bit
WG-26385	Fixed:	AndroidWwiseUnityCPU
WG-26395	Fixed:	MSBUILDWindows	Phone	8
WG-26430	Fixed:	iOSSetBasePath()

:

WG-25669:	Wwise	PickerAuto	PopulateMac	Editor
WG-25733:	WindowsiOS/Mac



Wwise	Unity	Integration	2014.1.1
	Wwise	2014.1.1Wwise	SDK

Wwise	SDK:	2014.1.1
Unity:	4.x	5.0

:

Wii	U
Plug-in	Registration
Unity	"Wwise	Settings"Wwise
GeneratedSoundBanksPopulate

:

WG-26201:	C#	System	:

WG-25669:	Wwise	PickerAuto	PopulateMac	Editor
WG-25733:	WindowsiOS/Mac

WG-25669:	Wwise	PickerAuto	PopulateMac	Editor
WG-25733:	WindowsiOS/Mac



Wwise	Unity	Integration	2014.1
Wwise	2014.1Wwise	SDK2013.2	Wwise
Unity	Integration

--	

2013.2	Wwise	Unity	Integration

Wwise	SDK:	2014.1
Unity:	4.x

--	

Android
iOS
Linux*

32-bit
64-bit

Mac	OS	X	(10.6	)
PS3
PS4
PS	Vita
Windows

32-bit
64-bit

Windows	8	(Metro)

IntelARMWindows	Store	App
Windows	Phone	8.0
Xbox360
Xbox	One

:



pg_wwisedemoscene	
2013.2	Wwise	Unity	Integration
WwiseWwise	Unity	IntegrationUUIDWwiseUnity

Wwise 	
Wwise AkAmbientInspector	
AkSoundEngine
WwiseGlobalAkListener

:

WG-25783:	Callback	Manager
WG-25677:	Mac

:

WG-25669:	Wwise	PickerAuto	PopulateMac	Editor
WG-25733:	WindowsiOS/Mac



Wwise	Unity	Integration	2013.2.9
Wwise	2013.2.9Wwise	SDK

--	 	--	:

Wwise	SDK:	2013.2.9
Unity:	4.x

--	

Android
iOS
Linux*

32-bit
64-bit

Mac	OS	X	(10.6	)
PS3
PS4
PS	Vita
Windows

32-bit
64-bit

Windows	8	(Metro)

IntelARMWindows	Store	App
Windows	Phone	8.0
Xbox360
Xbox	One

:

Windows	Phone	8.0



Wwise	Unity	Integration	2013.2.8
	Wwise	2013.2.8Wwise	SDKWwise-Unity

--	

Unity
Wwise	PickerWwise Wwise	Picker
Unity Wwise	Unity	Integration	Wwise	2015.1
Wwise	SDK

Wwise	SDK:	2013.2.8
Unity:	4.x

--	

Android
iOS
Linux*

32-bit
64-bit

Mac	OS	X	(10.6	)
PS3
PS4
PS	Vita
Windows

32-bit
64-bit

Windows	8	(Metro)

IntelARMWindows	Store	App
Windows	Phone	8.0
Xbox360
Xbox	One



:

Xbox	One
PS4
Linux
*	Unity	Integration	for	LinuxWwise	2013.2.8	Linux	BETA
Windows	Phone	8.0

WindowsMetroUnityScripting	Define	Symbol

IntegrationUnity	Editor
Integration
Windows	IDEVisual	Studio	20082010
WindowsMetro



Wwise	Unity	Integration	2013.2.5
Wwise	2013.2.5Wwise	SDK

Wwise	SDK:	2013.2,	2013.2.x
Unity:	4.x

--	

Android
iOS
Mac	OS	X	(10.6	)
PS3
PS4
PS	Vita
Windows

32-bit
64-bit

Windows	8	(Metro)

IntelARMWindows	Store	App
Xbox	360
Xbox	One

:

:	PS4
:	PS	Vita
:	Xbox	One
Android:	API	 AddBasePath()I/OPOSIX

:

WG-24351:	iOS:	



Wwise	Unity	Integration	2013.2.4
Wwise	2013.2.4Wwise	SDK

Wwise	SDK:	2013.2,	2013.2.x
Unity:	4.x

--	

Windows	8	(Metro)

IntelARMWindows	Store	App
Windows

32-bit
64-bit

Mac	OS	X	(10.6	)
iOS
Android
Xbox360
PS3

:

Integration Wwise	>	Help
Wwise	SDKVersion.txt

:

WG-24080:	Windows	APIMac	APIAndroid

Android	armeabi



Wwise	Unity	Integration	2013.2.1
	Wwise	2013.2.1Wwise	SDK

Wwise	SDK:	2013.2,	2013.2.1
Unity:	4.x3.x

--	

Windows	8	(Metro)

IntelARMWindows	Store	App
Windows

32-bit
64-bit

Mac	OS	X	(10.6	)
iOS
Android
Xbox360
PS3

:

Unity	IntegrationUnityUnity
Editor
WwiseUnity	EditorUI:

SoundBank	ID	C++	C#
Unity	4Scripting	Define	SymbolsWindows

IntegrationDemo
Android:	SoundBankAndroid	Expansion	Files	(OBB)

:

http://docs.unity3d.com/Documentation/Components/class-PlayerSettings40.html
http://developer.android.com/google/play/expansion-files.html


WG-23781:	Bank
WG-23734:	WindowsMarker
WG-23345:	Unity	Editor
WG-23436:	Unity:	
WG-23423:	UnityGameObject
WG-22533:	Unity:	API

iOS

	 Unity 	
	 	
iOSXcodeAPIpg_howtobuilddeployios

UI
Apple
SWIG2.0.11MacSWIGpg_compileswig

https://www.audiokinetic.com/library/2015.1.9_5624/?source=Unity&id=pg__howtobuildmultiarch.html


Wwise	Unity	Integration	2013.1.1
Wwise	2016.1Wwise	SDKIntegration



Wwise	Unity	Integration	2013.1
Wwise	2013.1Wwise	SDKAndroid

Wwise	SDK:	2012.2.x,	2013.1
Unity:	3.4.x,	3.5.x,	4.x

--	

Windows	8

IntelARMWindows	Store	App
Windows	(32bit)
Windows	(64bit)
Mac	OS	X	(10.6	)
iOS
Android
Xbox360
PS3

:

Android:	SoundBanksAndroid	(apk)	LoadBank()
API
Windows	64bit
Windows	8

: 	WG-22948:	PS3

WG-22938:	Mac	OSXUnity	Integration
WG-22334:	UnityMusic	userCue
WG-22329:	Unity	IntegrationPostEvent()
WG-22255:	Unity	Android:	
WG-22165:	3DiOSAndroid
WG-21933:	AkCallbackManager.csfloatUserCue
WG-21365:	Unity	iOS:	iOS



WG-22533:	API

1UnityWindowsMac

quietverbose
Python
IntegrationUnity

Integration	for	PS3Visual	Studio	2010
Python	2.6Python	2.7.x3.x
IntegrationUNITY_PROJECT_ROOTIntegration
UNITY_PROJECT_ROOT
AndroidPostprocessBuildPlayerUnity
IntegrationDemoUnity4
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Wwise	Unity	Integration	»	



2017.2
Wwise	2017.2Unity	Integration:

Edit	Mode
Edit

WwiseGlobal
Wwise	Audio	Input
MIDI
Automatic	SoundBank	Management



Edit	Mode
WwiseUnityEditPlayWwise AkEvent	(
AkAmbient)	Play/StopAkEvents
Play	MultipleStop	MultipleStop	All

Edit

EditAkBankLoad	On:AwakeUnload	On:Never



WwiseGlobal
WwiseGlobalAkEditorEventPlayerEdit
AkEventWwiseEventsWwiseGlobal	
AkGameObj 	AkAudioListener	Edit	 AkEnvironment

AkGameObj 	AkRoom	 Unity 	



Wwise	Audio	Input
Wwise	Audio	InputC#	 UnityAudio	Input	Source 	



MIDI
WwiseMIDIC#	 MIDIWwise 	



Automatic	SoundBank	Management
SoundBank	 1SoundBank 		 SoundBank 	



Spatial	Audio
UnityAPI	 	
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Wwise	Unity	Integration	»	



	2017.2
:

Pre-2017.2: New	in	2017.2:
ErrorCode AK.Monitor.ErrorCode

ErrorLevel AK.Monitor.ErrorLevel

DynamicSequenceType AK.SoundEngine.DynamicSequence.DynamicSequenceType

MultiPositionType AK.SoundEngine.MultiPositionType

PreparationType AK.SoundEngine.PreparationType

RTPCValue_type AK.SoundEngine.Query.RTPCValue_type

:

Pre-2017.2: New	in	2017.2:
Iterator AkIterator

Playlist AkPlaylist

PlaylistItem AkPlaylistItem
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Wwise	Unity	Integration	»	



2017.1
Wwise	2017.1Unity	Integration:

WwiseTypes
Unity	Integration
3D



[RequireComponent(typeof(AkGameObj))]	 AkEvent

AkEnvironment		 AkEnvironmentPortal		 Rigidbody	
Rigidbody		 AkEnvironment		 AkEnvironmentPortalno	
	 Rigidbody		 AkGameObj	"Environment	aware"
Rigidbody	Editor:	 AkGameObj-AkEnvironment	interactions
require	a	Rigidbody	component	on	the	object	or	the	environment.
AkGameObj-AkEnvironmentRigidbody

WwiseSettings Show	Warning	for	Missing	RigidBody



WwiseTypes
"WwiseTypes"WwiseEventSwitchesStates
Wwise

:

public	class	Footsteps	:	MonoBehaviour

{

				[Header("Wwise	Types")]

				public	AK.Wwise.Event	FootStepEvent	=	null;

				public	AK.Wwise.RTPC	SpeedRTPC	=	null;

				public	AK.Wwise.Switch	UnderFootMaterialSwitch	=

	null;

				public	AK.Wwise.Bank	FootStepBank	=	null;

				void	InitializeSound()	{	FootStepBank.Load();	}

				void	FinalizeSound()	{	FootStepBank.Unload();	}

				void	PlayFootStepSound(float	speed)

				{

								SpeedRTPC.SetValue(gameObject,	speed);

								UnderFootMaterialSwitch.SetValue(gameObject)

;

								FootStepEvent.Post(gameObject);

				}

}



Unity	Integration
AkSoundEngine	Launcher

https://www.audiokinetic.com/library/edge/?source=InstallGuide&id=integrating_wwise_into_an_unreal_or_unity_project


3D
Wwise3D AkGameObj

AkAudioListener	 AkGameObj		 AkAudioListener	
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	2017.1
AkCallbackManager

AkCallbackManager.AudioInterruptionCallback()	
public	delegate	AKRESULT	AudioInterruptionCallba

ck(bool	in_bEnterInterruption,	object	in_Cookie)

;

AkCallbackManager.BGMCallback()	
public	delegate	AKRESULT	BGMCallback(bool	in_bOt

herAudioPlaying,	object	in_Cookie);

AkCallbackManager.EventCallback()	
public	delegate	void	EventCallback(object	in_coo

kie,	AkCallbackType	in_type,	AkCallbackInfo	in_i

nfo);

	 AkCallbackManager	 AkCallbackInfoC++

	 gameObjID		 ulong	 IntPtr

	 AkCallbackManager.AkMidiEventCallbackInfo	
AkMIDIEventCallbackInfo"MIDI"
AkCallbackManager.AkMusicSyncCallbackInfoBase

AkMusicSyncCallbackInfo	
AkCallbackManager.AkMusicSyncCallbackInfo.segmentInfo

AkMusicSyncCallbackInfo.segmentInfo_*
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Unity
WwiseUnityIntegration	UnityPackageUnityWwiseUnity
Editor

Wwise	Integration	Package
Unity

SoundBank

Wwise	Integration	Package
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Wwise	Unity	Integration	»	Unity



Wwise:	 	

Unity:

Unity	5.5	PersonalPro
iOS Xcode	7.2	or	above	with	compatible	iOS	SDK
Linux libSDL2	(	Linux	)

Windows DirectX	End-User	runtime	
x64	Visual	Studio	2013	redistributable

Windows	32-bit	Debug x86	Visual	Studio	2013	redistributable
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Wwise	Unity	Integration	»	Unity



Wwise	Integration	Package
Wwise	Launcher Wwise	Launcher	WwiseUnity

	

LauncherUnity
WwiseUnity(Warning)
UnityUnity

https://www.audiokinetic.com/library/edge/?source=InstallGuide&id=integrating_wwise_into_an_unreal_or_unity_project


Unity	Integration
Launcher
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Wwise	Unity	Integration	»	Unity



Unity
Unity

Edit	>	Project	Settings	>	AudioDisable	Audio

"Create	WwiseGlobal	GameObject""Wwise
Global"Wwise	
WwiseGlobalAkEditorEventPlayer
AkAudioListenerAkGameObjEditAkEvent
RigidbodyAkEnvironmentAkRoomAkGameObj
Script	Execution	OrderWwise	( AkInitializer,	AkGameObj,
AkAudioListener,	AkBank,	AkTerminator)	
"Add	Ak	Listener	to	Main	Camera"Audio	Listener
Main	Camera	 AkAudioListener.cs

Play	in	BackgroundWwise	Profiler
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WwiseWwiseSoundBankWwise

1.	 WAVWindows	Explorer1Project	ExplorerAudio
Sound1

2.	 EventSound New	Event

3.	 SoundBankSoundBanksF7New
4.	 EventSoundBankEventProject	ExplorerSoundBank
5.	 Generate	SoundBanks	

Unity

1.	 Wwise	Picker		( Window	>	Wwise	Picker)Event
SoundBank

2.	 SoundBank
3.	 Event
4.	

	 	



UnityWwiseUnity

AkAmbient	
AkBank	SoundBank
AkEnvironment	Collider

--	Wwise	API2

WWISE	
	AK::SOUNDENGINE

Wwise	Unity	IntegrationThu	Feb	1	09:40:26	2018		 	1.6.3

https://www.audiokinetic.com/library/?source=SDK&id=workingwithsdks__integratingelements.html
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SoundBank
Unity	EditorSoundBankWwise GeneratedSoundBanks

Unity1 …SoundBank
WwiseSoundBankSoundBank
SoundBank BuildPlayerPipeline:	 Unity
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WwiseUnitySoundBank
:

Wwise
SoundBank
Unity
SoundBank StreamingAssetsEditor
Editor

	Unity

Wwise	Compressor
Wwise	Delay
Wwise	Expander
Wwise	Gain
Wwise	Matrix	Reverb
Wwise	Meter
Wwise	Parametric	EQ
Wwise	Peak	Limiter
Wwise	RoomVerb
Wwise	Silence
Wwise	Sine
Wwise	Tone	Generator

WwiseUnity	 Creating	New	Plug-ins	

Wwise	(McDSP,	iZotope,	Auro,	SoundSeed,	Crankcase	REV,
Convolution	Reverb,	Motion)

Wwise	Unity	IntegrationThu	Feb	1	09:40:26	2018		 	1.6.3

https://www.audiokinetic.com/library/?source=SDK&id=goingfurther__newplugins.html
https://www.audiokinetic.com/contacts/
http://www.doxygen.org/index.html
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Wwise	Integration	Package

	

UnityUnity
UnityUnity
WwiseUnity(Warning)
C++	AkSoundEngineC++ 	Wwise	SDK	 C++
Wwise	Integration	Package

Wwise	IntegrationUnity	 Wwise	Integration
Package 	UnityWwise	Integration
Wwise	LauncherWwise	Integration

	Wwise	IntegrationWwise

2WwiseUnity



WwiseWwise
1.	 UnityWwise	IntegrationWwise
2.	 Wwise	Project
3.	 Wwise'Yes'
4.	 Wwise	SoundBankUnityWwiseOnce	completed,

make	sure	to	regenerate	your	Wwise	SoundBanks	to	be	ready	to
carry	on	with	your	work	after	updating	the	Unity	project	to	the	new
Wwise	version.



UnityWwise
UnityWwiseWwise	Launcher
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Wwise	Integration	Package
Wwise	Integration	PackageUnityAssets/Wwise
Wwise
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Wwise	Unity	Integration



Wwise	Unity	Integration
:

AkAmbient	Use	this	component	to	attach	a	Wwise	Event	to	any
object	in	a	scene.	The	sound	can	be	started	at	various	moments,
dependent	on	the	selected	Unity	trigger.	This	component	is	more
useful	for	ambient	sounds	(sounds	related	to	scene-bound	objects)
but	could	also	be	used	for	other	purposes.	Since	AkAmbient	has
AkEvent	as	its	base	class,	it	features	the	play/stop,	play	multiple,
stop	multiple	and	stop	all	buttons	for	previewing	the	associated
Wwise	event.	.	AkAmbientInspector	
AkAudioListener	
Add	this	script	on	the	game	object	that	represent	a	listener.	This	is
normally	added	to	the	Camera	object	or	the	Player	object,	but	can	be
added	to	any	game	object	when	implementing	3D	busses.
isDefaultListener	determines	whether	the	game	object	will	be
considered	a	default	listener	-	a	listener	that	automatically	listens	to
all	game	objects	that	do	not	have	listeners	attached	to	their
AkGameObjListenerList's.	
AkBank	
Loads	and	unloads	a	SoundBank	at	a	specified	moment.	Vorbis
sounds	can	be	decompressed	at	a	specified	moment	using	the
decode	compressed	data	option.	In	that	case,	the	SoundBank	will	be
prepared.	
AkEmitterObstructionOcclusion	
Obstructs/Occludes	the	emitter	of	the	current	game	object	from	its
listeners	if	at	least	one	object	is	between	them.
AkEnvironment	
Use	this	component	to	define	a	reverb	zone.	This	needs	to	be	added
to	a	collider	object	to	work	properly.	AkEvironment
AkEvironmentPortalInspector	(Reverb	Zones) .	
AkEnvironmentPortal	
Use	this	component	to	define	an	area	that	straddles	two	different
AkEnvironments	zones	and	allow	mixing	between	both	zones.
AkEvironmentAkEvironmentPortalInspector	(Reverb	Zones) .	
AkEvent	
Wwise	EventUnityHelper



AkGameObj	
This	component	represents	a	sound	object	in	your	scene	tracking	its
position	and	other	game	syncs	such	as	Switches,	RTPC	and
environment	values.	You	can	add	this	to	any	object	that	will	emit
sound,	and	it	will	be	added	to	any	object	that	an	AkAudioListener	is
attached	to.	Note	that	if	it	is	not	present,	Wwise	will	add	it
automatically,	with	the	default	values,	to	any	Unity	Game	Object	that
is	passed	to	Wwise.	
AkRoom	
An	AkRoom	is	an	enclosed	environment	that	can	only	communicate
to	the	outside/other	rooms	with	AkRoomPortals.	
AkRoomPortal	
An	AkRoomPortal	can	connect	two	AkRoom	components	together.	
AkRoomPortalObstruction	
Obstructs/Occludes	the	spatial	audio	portal	of	the	current	game
object	from	the	spatial	audio	listener	if	at	least	one	object	is	between
them.	
AkSpatialAudioEmitter	
Add	this	script	on	the	GameObject	which	represents	an	emitter	that
uses	the	Spatial	Audio	API.	
AkSpatialAudioListener	
Add	this	script	on	the	game	object	that	represent	a	listener.	This	is
normally	added	to	the	Camera	object	or	the	Player	object,	but	can	be
added	to	any	game	object	when	implementing	3D	busses.
isDefaultListener	determines	whether	the	game	object	will	be
considered	a	default	listener	-	a	listener	that	automatically	listens	to
all	game	objects	that	do	not	have	listeners	attached	to	their
AkGameObjListenerList's.	
AkState	
This	will	call	AkSoundEngine.SetState()	whenever	the	selected	Unity
event	is	triggered.	For	example	this	component	could	be	set	on	a
Unity	collider	to	trigger	when	an	object	enters	it.	
AkSurfaceReflector	
This	component	will	convert	the	triangles	of	the	GameObject's
geometry	into	sound	reflective	surfaces.	
AkSwitch	
This	will	call	AkSoundEngine.SetSwitch()	whenever	the	selected	Unity
event	is	triggered.	For	example	this	component	could	be	set	on	a
Unity	collider	to	trigger	when	an	object	enters	it.	



:
Wwise	Picker

:

AK.Wwise.AuxBus	
This	type	represents	an	auxiliary	send	in	the	Master-Mixer	Hierarchy.
AK.Wwise.Bank	
This	type	can	be	used	to	load/unload	SoundBanks.	
AK.Wwise.CallbackFlags	
This	type	represents	the	values	of	the	flags	used	when	posting	an
Event	with	a	callback.	
AK.Wwise.Event	
This	type	can	be	used	to	post	Events	to	the	sound	engine.	
AK.Wwise.RTPC	
This	type	can	be	used	to	set	game	parameter	values	to	the	sound
engine.	
AK.Wwise.State	
This	type	can	be	used	to	set	Wwise	States.	
AK.Wwise.Switch	
This	type	can	be	used	to	set	Switch	values	on	gameobjects.	
AK.Wwise.Trigger	
This	type	can	be	used	to	post	triggers	to	the	sound	engine.	

:
Wwise	Types



Wwise
3

Wwise	Picker	 	EventWwise	PickerUnity	Viewer
InspectorAkAmbientGame	Object
Add	Component 	AkAmbientAkEventUnity	Game
Object
Wwise	Types	 		 AK.Wwise.Event.Post()	C#

		 AkSoundEngine.PostEvent()	C#



AkAmbientInspector
AkAmbient:	

Trigger	On:	
UnityAkSoundEngine.PostEvent

Wwise 	
Event	Name:	

Picker
Action	On	Event:	
WwiseUnity

Action	On	Event	Type:	

Curve	Interpolation:	

Fade	Time:	

Use	Callback:	

Game	Object:	

Callback	Function:	
Game	Object

Callback	Function
Game	Object1 Callback	Function
:	 void	FunctionName(AkEventCallbackInfo
in_info)
Callback	Flags:	
Callback	Function Wwise	 	
AkCallbackType

Play	/	Stop:	
EditWwise
Stop	All:	
Wwise
Position	Type:	
AudioEngine

Simple_Mode:	

https://www.audiokinetic.com/library/?source=SDK&id=_ak_callback_8h_a948c083ff18dc4c8dfe1d32cb0eb6732.html


Large_Mode:	

MultiPosition_Mode:	
AkAmbient1
AkAmbient
AkambientAkEvent
AkAmbient
Show	Attenuation	Sphere:	

Max	Attenuation	 Wwise	SoundBank(project-
>project	settings->soundbanks->Max	attenuation)

Dont_Show:	

Current_Event_Only:	
	 AkSoundEngine.PostEvent	
Simple_Mode
Large_Mode
ifMultiPosition_Mode MultiPosition_ModeAkAmbient

All_Events:	
AkAmbient



WwiseUnity	Timeline
UnityTimelineWwiseWwise	RTPCWwise

:
WwiseTimeline



AkEvironmentAkEvironmentPortalInspector
(Reverb	Zones)
WwiseReverb	Zone	 Environment		 Auxiliary	Sends	
Wwise

AkEnvironmentAkEnvironmentCollider
AkEnvironment:

Wwise	Picker	 	AkEnvironmentAuxBusWwise	Picker
Unity	ViewerInspectorAkAmbientGame	Object
"Add	Component" 	AkEnvironmentUnity	Game
ObjectInspector

		 AK::SoundEngine::SetGameObjectAuxSendValues()	C#

2
22

UnityGameObject->Wwise->Envrionment	Portal

AkGameObj
AkEnvironmentPortalAkEnvironmentInspector2

Wwise44:

4
4:

4 DefaultExclude	Others
Default

Exclude	Others

AkEnvironment	component:	
4

Priority:	



54
Default:	

21
Exclude	Others:	

Exclude	Others
Exclude	Others21

AuxBus	Name:	
AuxBusAuxBusAuxBusAuxBusAuxBus

OkAuxBusAuxBus	Wwise	Picker
AuxBus

AkEnvironmentPortal	component:	
UnityGameObject->Wwise->Environment	Portal
2
1

Environment	#1:	
	
Environment	#2:	
	
Axis:	

ZXZ

:

Aux
AK::SoundEngine::SetGameObjectAuxSendValues

https://www.audiokinetic.com/library/?source=SDK&id=integrating__elements__environments.html
https://www.audiokinetic.com/library/?source=SDK&id=namespace_a_k_1_1_sound_engine_a18f56e8e0e881c4efb9080545efbb233.html


C#
Wwise	SDK	 AkSoundEngine	UnityC++		 AK::SoundEngine	
AK::MusicEngine	SDKAPI API	Wwise
API	 GameObjectID	GameObjectUnity
AkGameObjGameObject

EventBankID

Wwise	APIIDWwiseC#	 Wwise_IDs.h	
Wwise_IDs.cs	 Assets	>	Wwise	>	Convert	Wwise	SoundBank
IDsPython

MIDIWwise

MIDIWwise	 AkMIDIPostArray		 AkMIDIPost	fill:

AkMIDIPostArray.PostOnEvent()

AkSoundEngine.PostMIDIOnEvent()

AK.Wwise.Event.PostMIDI()

MIDI

public	class	MyMIDIBehaviour	:	UnityEngine.MonoBehav

iour

{

				public	AK.Wwise.Event	SynthEvent;

				private	void	Start()

				{

								AkMIDIPostArray	MIDIPostArrayBuffer	=	new	Ak

MIDIPostArray(6);

								AkMIDIPost	midiEvent	=	new	AkMIDIPost();

								midiEvent.byType	=	AkMIDIEventTypes.NOTE_ON;

								midiEvent.byChan	=	0;



								midiEvent.byOnOffNote	=	56;

								midiEvent.byVelocity	=	127;

								midiEvent.uOffset	=	0;

								MIDIPostArrayBuffer[0]	=	midiEvent;

								midiEvent.byOnOffNote	=	60;

								MIDIPostArrayBuffer[1]	=	midiEvent;

								midiEvent.byOnOffNote	=	64;

								MIDIPostArrayBuffer[2]	=	midiEvent;

								midiEvent.byType	=	AkMIDIEventTypes.NOTE_OFF

;

								midiEvent.byOnOffNote	=	56;

								midiEvent.byVelocity	=	0;

								midiEvent.uOffset	=	48000	*	8;

								MIDIPostArrayBuffer[3]	=	midiEvent;

								midiEvent.byOnOffNote	=	60;

								MIDIPostArrayBuffer[4]	=	midiEvent;

								midiEvent.byOnOffNote	=	64;

								MIDIPostArrayBuffer[5]	=	midiEvent;

								SynthEvent.PostMIDI(gameObject,	MIDIPostArra

yBuffer);

				}

}

UnityAudio	Input	Source

Audio	Input	SourceC#Wwise	SDK

Audio	Input	Source

public	class	MyAudioInputBehaviour	:	UnityEngine.Mon

oBehaviour

https://www.audiokinetic.com/library/edge/?source=SDK&id=referencematerial__audioinput.html


{

				public	AK.Wwise.Event	AudioInputEvent;

				public	uint	SampleRate	=	48000;

				public	uint	NumberOfChannels	=	1;

				public	uint	SampleIndex	=	0;

				public	uint	Frequency	=	880;

				private	bool	IsPlaying	=	true;

				//	Callback	that	fills	audio	samples	-	This	func

tion	is	called	each	frame	for	every	channel.

				bool	AudioSamplesDelegate(uint	playingID,	uint	c

hannelIndex,	float[]	samples)

				{

								for	(uint	i	=	0;	i	<	samples.Length;	++i)

												samples[i]	=	UnityEngine.Mathf.Sin(Frequ

ency	*	2	*	UnityEngine.Mathf.PI	*	(i	+	SampleIndex)	

/	SampleRate);

								if	(channelIndex	==	NumberOfChannels	-	1)

												SampleIndex	=	(uint)(SampleIndex	+	sampl

es.Length)	%	SampleRate;

								//	return	false

								return	IsPlaying;

				}

				//	Callback	that	sets	the	audio	format	-	This	fu

nction	is	called	once	before	samples	are	requested.

				void	AudioFormatDelegate(uint	playingID,	AkAudio

Format	audioFormat)

				{

								//	Channel	configuration	and	sample	rate	are

	the	main	parameters	that	need	to	be	set.

								audioFormat.channelConfig.uNumChannels	=	Num

berOfChannels;

								audioFormat.uSampleRate	=	SampleRate;



				}

				private	void	Start()

				{

								//	The	AudioInputEvent	event,	that	is	setup	

within	Wwise	to	use	the	Audio	Input	plug-in,	is	post

ed	on	gameObject.

								//	AudioFormatDelegate	is	called	once,	and	A

udioSamplesDelegate	is	called	once	per	frame	until	i

t	returns	false.

								AkAudioInputManager.PostAudioInputEvent(Audi

oInputEvent,	gameObject,	AudioSamplesDelegate,	Audio

FormatDelegate);

				}

				//	

				public	void	StopSound()

				{

								IsPlaying	=	false;

				}

				private	void	OnDestroy()

				{

								AudioInputEvent.Stop(gameObject);

				}

}

Unity

	 AkGameObj	Unity	 gameObject	transform
1Unity
2

AkGameObjUnity GetPosition() 	GetForward()
GetUpward()	3	 AkGameObj	Unity
gameObjects	



	 AkAudioListener	Wwise
AkAudioListener		 AkGameObj	MainCamera
AkAudioListener	Unity	 gameObject	
Unity	

#if	!(UNITY_DASHBOARD_WIDGET	||	UNITY_WEBPLAYER	||	U

NITY_WII	||	UNITY_WIIU	||	UNITY_NACL	||	UNITY_FLASH	

||	UNITY_BLACKBERRY)	//	Disable	under	unsupported	pl

atforms.

//

//	Copyright	(c)	2017	Audiokinetic	Inc.	/	All	Rights

	Reserved

//

using	UnityEngine;

using	System;

using	System.Collections.Generic;

[AddComponentMenu	("Wwise/AkGameObj3rdPersonCam")]

[ExecuteInEditMode]	//ExecuteInEditMode	necessary	to

	maintain	proper	state	of	isStaticObject.

public	class	AkGameObj3rdPersonCam	:	AkGameObj

{

				public	Transform	target;												//	The	posit

ion	that	this	camera	will	be	following.	InspectorUni

ty	gameObject

				

				//	

				public	override	Vector3	GetPosition	()

				{

								return	target.GetComponent<AkGameObj>	().Get

Position	();

				}



}

#endif	//	#if	!(UNITY_DASHBOARD_WIDGET	||	UNITY_WEBP

LAYER	||	UNITY_WII	||	UNITY_WIIU	||	UNITY_NACL	||	UN

ITY_FLASH	||	UNITY_BLACKBERRY)	//	Disable	under	unsu

pported	platforms.
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Wwise	Picker
Wwise	PickerWwiseEventSwitchWwise	Picker
Wwise	SettingsMenu	 Edit	>	Wwise	Settings...Wwise
Unity

WwiseWwise	Picker Wwise	Picker
Refresh	ProjectWwiseSoundBankXML

Wwise	PickerWwise	Picker	

+-



SoundBank
SoundBank Generate	SoundBanksSoundBankWwise
PickerSoundBankWwiseUnity:	
WwiseUnity:	SoundBanks	generation	successfulWwiseUnity:	SoundBanks

generation	has	warning(s)	 WwiseUnity:	SoundBanks	generation

error ConsoleSoundBank

	Wwise	SettingsWwise	Windows	Installation	Path	Mac
Wwise	ApplicationUnity Generate	SoundBanksWwise
Unity



Wwise	Picker	
Wwise	PickerGame	ObjectInspector
:

Event AkAmbient
SoundBank AkBank.
Switch	Value AkSwitch
State	Value AkState
Aux	Bus AkEnvironment
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Wwise	Types
Wwise	TypesWwiseSoundBanksEvents
StatesSwitchesWwise	TypesEvent

Wwise	Types:

public	class	WwiseTypesExample	:	UnityEngine.MonoBeh

aviour

{

				public	AK.Wwise.Bank	MyBank	=	null;

				public	AK.Wwise.Event	MyEvent	=	null;

				public	AK.Wwise.RTPC	MyRTPC	=	null;

				public	void	Awake()

				{

								MyBank.Load();

				}

				public	void	Start()

				{

								MyEvent.Post(gameObject);

				}

				private	float	CalculateMyValue()

				{

								return	(float)System.Math.Sin(System.Math.PI

	*	UnityEngine.Time.timeSinceLevelLoad);

				}

				public	void	Update()

				{

								MyRTPC.SetValue(gameObject,	CalculateMyValue

());

				}



}

inspector:

WwiseTypesExamplemarker	callbacks

public	AK.Wwise.CallbackFlags	MyCallbackFlags	=	null

;

public	void	Start()

{

				MyEvent.Post(gameObject,	MyCallbackFlags,	EventC

allback);

}

private	void	EventCallback(object	cookie,	AkCallback

Type	type,	AkCallbackInfo	info)

{

				if	(type	==	AkCallbackType.AK_Marker)

				{

								var	markerInfo	=	info	as	AkMarkerCallbackInf

o;

								if	(markerInfo	!=	null)

								{

												//	...

								}

				}

}
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Wwise
UnityWwise"Trigger	On"WwiseEventSwitchState
UnityUnityIntegration

	 AkTriggerBase	C#AkTriggerBase"Trigger	On"
triggerDelegate(GameObject	in_target)

"target"ColliderWwiseColliderPost

	 GetComponent<YourTriggerClass>

().triggerDelegate(GameObject	in_target)	

	AkTriggerBase32

:

public	class	TriggerOnGunHit	:	AkTriggerBase

{

				void	Hit()

				{

								if(triggerDelegate	!=	null)	

								{

												triggerDelegate(null);

								}

				}

}

:

if	(playerIsShot)

{

				GetComponent<TriggerOnGunHit>().Hit();

}

TriggerOnGunHitWwise
AK::SoundEngine::PostEvent("GunHit",	gameObject)	Wwise	SDK



Wwise
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WwiseTimeline
TimelineUnity

Timeline Timeline	Docs

TimelineTimeline Timeline	Usage

https://docs.unity3d.com/Manual/TimelineOverview.html
https://docs.unity3d.com/Manual/TimelineWorkflowCreatingAssetInstance.html


WwiseTimeline
Wwise	Unity	Integration	 AkRTPC		 AkEvent	2 AkRTPC
TrackGame	Parameter	 AkEvent	Track	Wwise	EventUnity
Timeline	 AkRTPC		 AkEvent	"Add"

Adding	AK	tracks	to	Timeline

Ak

AkEvent		 AkRTPC	NoneEvent
RTPCTimelinePlayableDirector
Timeline

AkRTPC

AkRTPC	1	 Parameter	Wwise
RTPC

RTPC	



Wwise	Timeline

AkEvent		 AkRTPC		 AkEventPlayable	
	 AkRTPCPlayable	

AKAK

Timeline

Timeline Clip	Properties

AkRTPCPlayable

	 AkRTPCPlayable	

AkRTPCPlayable

Set	RTPC	Globally:	RTPC

https://docs.unity3d.com/Manual/script-EditorClip.html


Override	Track	Object:	RTPC	ObjectRTPC Set
RTPC	Globally
RTPC	Object:	RTPC NoneRTPC
NoneTimeline Override	Track	Object	

Animated	Value:	RTPC	Value:	RTPC
RTPCPlayable

TimelineRTPC

RTPCRTPCUnity



RTPC

RTPC

AkEventPlayable

	 AkEventPlayable	



AkEventPlayable

Override	Track	Object:	
NoneTimeline	 Ak
Emitter	Object	Ref:	 Override	Track	Object
Event:	Wwise



UnityPlayEditUnity	PlayableUnity:
953109Edit"Play	from	anywhere"Edit

https://fogbugz.unity3d.com/default.asp?953109_kitf7pso0vmjm0m0


Wwise	Project	Setup
	 AkAudioEvent	Tracks	JSONWwise
Project	SettingsSoundBanks Metadata	Options
Estimated	duration SoundBank	Settings Generate
JSON	Metadata



AkEvent
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Unity
UnityUnitySoundBank
pre-build	stepspost-build	steps	 Edit	>	Wwise	Settings...



Wwise
UnityWwise	 Profile	
Wwise	
Wwise	>	Activate	PluginsWwise Release

	Debug	Audiokinetic

:

Android
pg_howtobuilddeployios
Linux
UnityWwise



StreamingAssets
UnityUnity	 Assets		 StreamingAssets	Unity
:	 <UNITY_PROJECT_ROOT>\Assets\StreamingAssets.	Unity
Unity StreamingAssets

SoundBank Audio\GeneratedSoundBanks	 StreamingAssets	
Unity	WwisePlatform	Manager
<UNITY_PROJECT_ROOT>\Assets\StreamingAssets\Audio\GeneratedSoundBanks\

<YourPlatform>

	AkInitializer::basePathSoundBanks

Unity	EditorSoundBankWwiseProject	SettingsWwise
GeneratedSoundBankWindowsMac

http://unity3d.com/support/documentation/Manual/StreamingAssets.html


1SoundBank
1SoundBank	 StreamingAssets	Wwise
SoundBank	 StreamingAssets 	SoundBank
pre-build	steps Wwise	Settings



SoundBank
SoundBank

WwiseiOSiPadiPhone
UnityWwise 	



WwiseSoundBankTXTXMLSoundBank
	 StreamingAssets	
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Android
APKAndroidSoundBankLoadBank()	API StreamingAssets

SoundBankUnityAPK AssetsLow-Level 	IOSoundBankAPK

Low-Level	IOAndroidSoundBankSDCard
	 AkSoundEngine.AddBasePath(YourPath)	APK
APKAPKDLC

UnityiOS BuildBuild	and	RunUnity	EditorUnityXcode
Unity

UNITY_PROJECT_ROOT/Assets/Plugins/iOS

UnityThumbXcodeThumb



Wwise	Integration	 libAkSoundEngine.a	
(iOS)	Player	Settings Other	Settings Stripping	Level
12MB
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Linux
UnityLinuxUnity	Editor BuildBuild	RunUnity
Linux .x8632	bit.x86_6464	bit

Wwise	Unity	Integration libSDL2	
"DLLNotFoundException"

libSDL2	Ubuntu	12.04:

sudo	apt-get	install	build-essential	libasound2-dev

wget	http://www.libsdl.org/release/SDL2-2.0.3.tar.gz

tar	-zxvf	SDL2-2.0.3.tar.gz

cd	SDL2-2.0.3

./configure

make

sudo	make	install

sudo	ldconfig

libsdl.org
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UnityWwise
Wwise	Unity	IntegrationWwise
C#

SoundBank	 GetPlatformName	
SoundBank



UNITY_PROJECT_ROOT/Assets/Wwise/Deployment/Components/AkBasePathGetter.cs

GetPlatformName()	



iOSiOS3:	iPodiPhone
iPad1

1.	 Wwise3Platform	Manager:	"iPod",	"iPhone",
"iPad"WwisePlatform	ManagerWwise Wwise	Help	>
Setting	Up	Your	Projects	>	Managing	Platforms

2.	 Unity AkBasePathGetterC#:
public	partial	class	AkBasePathGetter

{

#if	UNTIY_IOS

				static	partial	void	GetCustomPlatformName(re

f	string	platformName)

				{

								switch(UnityEngine.iOS.Device.generation

)

								{

												case	UnityEngine.iOS.DeviceGeneratio

n.iPodTouch1Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPodTouch2Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPodTouch3Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPodTouch4Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPodTouch5Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPodTouchUnknown:

																platformName	=	"iPod";

																break;

												case	UnityEngine.iOS.DeviceGeneratio

n.iPad1Gen:

												case	UnityEngine.iOS.DeviceGeneratio

https://www.audiokinetic.com/library/?source=Help&id=managing_platforms


n.iPad2Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPad3Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPadMini1Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPad4Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPadAir1:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPadMini2Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPadMini3Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPadAir2:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPadUnknown:

																platformName	=	"iPad";

																break;

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhone:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhone3G:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhone3GS:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhone4:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhone4S:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhone5:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhone5C:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhone5S:

												case	UnityEngine.iOS.DeviceGeneratio



n.iPhone6:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhone6Plus:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhoneUnknown:

												default:

																platformName	=	"iPhone";

																break;

								}

				}

#endif

}

platformName	Unity

3.	 (a)	AkBuildPreprocessorC#(b)	 AkBuildPreprocessorC#
:
public	class	WwiseIOSBuildPreprocessor	:	IPrepro

cessBuild,	IPostprocessBuild

{

				public	int	callbackOrder	{	get	{	return	0;	}

	}

				string	iPodDestinationSoundBankFolder	=	stri

ng.Empty;

				string	iPadDestinationSoundBankFolder	=	stri

ng.Empty;

				string	iPhoneDestinationSoundBankFolder	=	st

ring.Empty;

				

				public	void	OnPreprocessBuild(BuildTarget	ta

rget,	string	path)

				{

								if	(target	==	BuildTarget.iOS)

								{

												AkBuildPreprocessor.CopySoundbanks(t

rue,	"iPod",			iPodDestinationSoundBankFolder);

												AkBuildPreprocessor.CopySoundbanks(t



rue,	"iPad",			iPadDestinationSoundBankFolder);

												AkBuildPreprocessor.CopySoundbanks(t

rue,	"iPhone",	iPhoneDestinationSoundBankFolder)

;

								}

				}

				public	void	OnPostprocessBuild(BuildTarget	t

arget,	string	path)

				{

								DeleteSoundbanks(iPodDestinationSoundBan

kFolder);

								DeleteSoundbanks(iPadDestinationSoundBan

kFolder);

								DeleteSoundbanks(iPhoneDestinationSoundB

ankFolder);

				}

}

4.	 Wwise"iPhone""iPod""iPad"3SoundBank3
UNITY_PROJECT_ROOT/Assets/StreamingAssets/Audio/GeneratedSoundBanks

5.	 UnityiOS
6.	 SoundBank
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WwiseUnityDLC

Wwise

DLCWwiseFile	PackageAuthoring:	 Wwise	>	Help	>
Finishing	Your	Project	>	Managing	File	Packages	>	Downloadable
Content	OverviewBNKWEMDLC
Wwise/UnityLow-Level	IO

UnityAkInitializerBase	Path
AkSoundEngine.LoadFilePackage()	Wwise

Base	PathiOSAndroid

AndroidiOS
AkSoundEngine.LoadFilePackage()		 AkSoundEngine.AddBasePath()	
Operating	System:

#if	UNITY_IPHONE												

				string	fileNameBase	=	Application.dataPath.Subst

ring(0,	Application.dataPath.LastIndexOf('/'));

				fileName	=	fileNameBase.Substring(0,	fileNameBas

e.LastIndexOf('/'))	+	"/Documents/"	+	FILE_NAME;

#elif	UNITY_ANDROID

				fileName	=	Application.persistentDataPath	+	"/"	

+	FILE_NAME	;

#else

				fileName	=	Application.dataPath	+	"/"	+	FILE_NAM

E;

#endif

Androidsdcard

:
OBB	(Android)

https://www.audiokinetic.com/library/?source=Help&id=dlc_overview


Unity	WWW
UnityWWWDLCAkMemBankLoader.cs
Wwise	IO
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Wwise-UnityC#Wwise	API
IntegrationC++C++



1.	 Wwise	LauncherWwise	SDK
2.	 WwiseUnityOSWindowsMacsourcezip

LauncherUnityzipzip_Src.zip
3.	 WindowsMaczip
4.	 Integration	 	
5.	 zip	 Unity 	
6.	 2:	 Console 		 Integrated	Development

Environment	(IDE) .
7.	 	 Deployment	API



Notes
	 Build	Log	



Integration:

All
platforms

Unity	5	PersonalPro
Wwise	SDK	 	
SDK	Wwise	SDK
>	Platform	Requirements
Python	2.7.x3.xPhthon

Android

Cygwin	(Windows)
Android	SDK:	32bitAPI964bitAPI21
Android	NDK	r10e.
Apache	Ant	1.8.4.
Wwise	SDK
Unity
:

CYGWIN_HOME	CygwinWindows
ANDROID_HOME	Android	SDK
ANDROID_NDK_ROOT	Android	NDK
ANT_HOME	Apache	Ant

iOS Xcode	7.2
iOSWwise	SDK	 WWISESDK	

Linux
Build-essential	(sudo	apt-get	install	build-essential)
SDL2	(SDL2	 Linux	)
LinuxWwise	SDK	 WWISESDK	

Mac Xcode	7.2
MacWwise	SDK	 WWISESDK	

PS4 Visual	Studio	2012	Professional	Edition.



Windows Visual	Studio	2013	Professional	Edition.
Windows
Store Visual	Studio	2015.

Xbox
One Visual	Studio	2012	Professional	Edition.



Wwise	SDKIntegration
WwiseUnityAssetsIntegration
Assets



StreamingAssets:	SoundBank	 1SoundBank 	
Wwise:	

Deployment:	Integration
API:	C++		C#	Wwise	SDK
Dependencies:	Unity
Components:	Unity
Plug-ins:	Unity

Platform
Architecture:	

Debug:		 Debug	 Wwise	for	detail

Profile:		 Profile	 Wwise	for
detail	
Release:		 Release	 Wwise	for
detail	
DSP:	Wwise

Documentation:	Integration
Editor:	WwiseUnityIntegrationEditor	WindowInspector
Tools:	



Wwise:	
AkSoundEngine:	IntegrationIDC

Common:	
Platform:	IDE

Integration/Assets/Wwise/Deployment:	Integration

API:	API
Generated:	SWIGAPI
Handwritten:	API

Components:	Unity
Plugins:	WwiseAkSoundEngine

<platform>:	
<architecture>:	



Console
Integration
Wwise\AkSoundEngine\Common\BuildWwiseUnityIntegration.py	
1:

python	BuildWwiseUnityIntegration.py	-h



Integrated	Development	Environment	(IDE)
Wwise	Unity	Integration:

WwiseUnityIntegration_version_platform_Src.zip\Wwise

\AkSoundEngine\YourPlatform

XcodeIntegrationIDE

Mac		iOSXcode

	 $WWISESDK		 -w		 WWISESDK	XcodeXcode
IDEWWISESDKXcodeMaciOS
AkSoundEngine{platform}	Build	SettingsUser-Defined
	 WWISESDK	 WWISESDK	(ex:	/Users/myUser/Wwise/SDK	)

Linux

Linux:

cd	<Integration	source	location>/AkSoundEngine/Common

./premake4	--akplatform=Linux	gmake

make	-f	AkSoundEngineLinux.make	config=<config>

<config> debug32,	profile32,	release32,	debug64,	profile64,	
release64 <Integration	source	location>/Deployment/Plugins/Linux



Wwise\Deployment\Plugins\[Platform]Assets\Wwise
Assets



Under	the	hood
SWIGWwise	SDKAPIUnity
WwiseUnitySWIGAPIWwise	for	Unity
SWIGC++

:

1.	 Wwise	SDKUnityWindowsMac	OS	X(.bundle)	iOS
	(.a)Android1Deployment	

	

:

Build	Log
C++Wwise	Integration	Package
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Build	Log
WarningUnity	EditorBuild	LogBuild	LogIntegration
	Build	Log

UNITY_PROJECT_ROOT\Assets\Wwise\Logs\BuildWwiseUnity

Integration.log

Time:	Message	type:	Source	Code	File	name	(Module	na

me):	Line	number:	Message	body

2013-09-26	09:29:56,490:	INFO:	BuildWwiseUnityIntegr

ation.py	(WindowsBuilder):	91:	Building:	Windows	(Wi

n32,	Debug)	...

1Unity	Integration
BuildUtil.CreateLogger()	

WwiseUnityIntegration_version_platform_Src.zip\Wwise

\AkSoundEngine\Common\AkSoundEngine\Common\BuildUtil

.py

Python	logging.handlers	module

IDEVisual	Studio IDE
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C++Wwise	Integration	Package

	

UnityUnity
UnityUnity
WwiseUnity(Warning)

Wwise	IntegrationUnity	 Wwise	Integration
Package 	UnityWwise	Integration
LauncherWwise	Integration

	Wwise	IntegrationWwise

3WwiseUnity



UnityWwise
Wwise	LauncherUnityWwise



WwiseWwise
1.	 UnityWwise	IntegrationWwise
2.	 Wwise	Project
3.	 Wwise'Yes'
4.	 Wwise	SoundBankUnityWwiseOnce	completed,

make	sure	to	regenerate	your	Wwise	SoundBanks	to	be	ready	to
carry	on	with	your	work	after	updating	the	Unity	project	to	the	new
Wwise	version.

5.	 SoundBankUnityStreamingAssets



C++
1.	 Wwise	SDK
2.	 UnityUnity	Integration	Source	Codezip
3.	 Unity	Integration	Source	Code
4.	 Unity	Integration	Source	Code
5.	
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API
Wwise	SDKIntegration:

UnloadBank()	2
iOSAPI
AK::SoundEngine::iOS::ListenToAudioSessionInterruption()	
GetGameObjectFromPlayingID()	WindowsGameObject	ID
32bitWindows	32bit64bit
PostEvent()		GameObjectAPIGameObject	 null	

PostEvent()	
AK::Monitoring::SetLocalOutput()	
AkCallbackManager.SetMonitoringCallback()	
AK::SoundEngine::SetPosition()	
AkSoundEngine.SetObjectPosition()	
PostEvent()	External	Sources1

	 AK::SoundEngine::DynamicSequence	APIUnity	API
SWIG
AK::SoundEngine::DynamicSequence::Open()	API
AkSoundEngine.Open()	API
AkSoundEngine.DynamicSequenceOpen()	
C++Unity	 AkArray::operator[]	
AkPlaylistArray.ItemAtIndex(uint	uiIndex)	SWIGC++

API:
iOSAPI
AkSpeakerVolumeMatrixCallbackInfo

AkSpeakerVolumeMatrixBusCallbackInfo

AkBusCallbackFunc

AK::SoundEngine::RegisterBusVolumeCallback

AK::SoundEngine::RegisterCodec

AK::SoundEngine::RegisterGlobalCallback

AK::SoundEngine::RegisterPlugin

AK::SoundEngine::Query::AkGameObjectsList

AK::SoundEngine::Query::GetActiveGameObjects()

AK::SoundEngine::Query::GameObjDst



AK::SoundEngine::Query::AkRadiusList

AK::SoundEngine::Query::GetMaxRadius(AkRadiusList&

io_RadiusList)

Event
AK::SoundEngine::DynamicDialogue::ResolveDialogueEvent	

:
.
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Android

Android
Background	Mode	(Android)
OBB	(Android)
WwiseUnityDLC



iOS
pg_howtobuilddeployios
	(iOS)
WwiseUnityDLC



Linux
Linux



Windows	Store	Apps
Windows	Store	Apps
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Background	Mode	(Android)
	 AK::SoundEngine::Suspend()	
AkSoundEngine.WakeupFromSuspend()	AkInitializer
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OBB	(Android)

Overview	of	the	OBB	and	Wwise	IO

AndroidUnity Player	Settings	>	Publishing	Settings	>	Split
Application	Binary,	APK	Expansion	Files.obbZip
SoundBankStreamingAssetsAndroid	SoundBank
SoundBankAPKOBB

OBBAkSoundEngine.SetBasePathOBBOBB
I/OOBBpersistent	CPU

http://developer.android.com/google/play/expansion-files.html


AkMemBankLoader.csSoundBank
:

1.	 SoundBank.
2.	 InspectorSoundBank Bank	Name
3.	 SoundBankInspector	 Is	Localized	Bank	

AkInitializer.cs	
4.	 SoundBank

2	 AkMemBankLoader.LoadNonLocalizedBank()	
AkMemBankLoader LoadLocalizedBank()	SoundBank



SoundBankIOZip
SoundBankIntegration
streamingmanager_lowlevel	
11SoundBankSoundBank
SoundBankAPIAPIIntegration
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	(iOS)
Unity	Integration2

AkAudioSessionCategorySoloAmbient	(Default)	
SilentiPhoneRing/Silent

AkAudioSessionCategoryAmbient		AmbientSound	

BGM	(BackGround	Music)
UI
AkCallbackManager.SetBGMCallback()	

SoloAmbientBGMAmbient
BGMBGM

	iOSSuspendWakeupFromSuspend
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Windows	Store	Apps
Universal	Windows	PlatformWindows	SoundBanks2SDK
SoundBank
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Wwise
Wwise	Unity	IntegrationWwise	LauncherUnity"Recent
Unity	Projects"UnityIntegration



Wwise	Demo	GameWwise	Launcher Wwise
LauncherUnityWwise

The	generated	SoundBanks	are	included	in	the	package.
Wwise	Project <DEMO_SCENE_ROOT>/WwiseProjectWwise
AssetsDemo



The	Wwise	Demo	Game	is	intended	as	a	way	to	preview	and	show	how
the	Wwise	Unity	Integration	can	be	used	in	the	Unity	Editor.

Wwise	Demo	Game:

1.	 LauncherUnityWwise	Demo	Game	Unity Modify	Wwise	in
Project...
1.	 LauncherUnity

2.	 Deployment	Platform Modify
3.	 Unity
4.	 SoundBank
5.	 Generated	SoundBanks StreamingAssets/Audio

6.	 Unity



Wwise
3D""For	each	station,	there	is	a	small
description	on	a	sign	next	to	the	station.	

Footsteps

Wwise	ProjectRandomSwitch	 Footstep	
	 Footstep_material	

4

Box	Collider Footstep_Material	Switch	ValueWwise	Picker
WindowBox	ColliderFirst	Person	ControllerColliderSwitch
"AkTriggerEnter"Ak	Switch"Use	Other	Object"
Inspector	Window

0.3	 Footstep	First	Person	ControllerWwise
SoundEngine

Subtitle

Unity

Delegate	 AkTriggerButtonPress	Delegate
	 AkTriggerBase		 triggerDelegate	 AkTriggerBase	
Wwise	Component	Inspector"trigger"Ak	Ambient
Wwise 	

WAVAk	AmbientInspector"Use
Callback"( SubtitleDemo.cs)GameObject	(
Object"Callback	Function	(
Callback	Flags"Marker" SubtitleDemo	Callback
	 MarkerCallback		 uIdentifier		 AkAmbient
Inspector 	



Environment

StationEnvironmentZone21Box	Collider
AuxBusWwise	Picker

Wwise2Auxiliary	BusLittle	Sequence"Use	game-
defined	Auxiliary	sends"

EnvironmentZoneWwiseAuxBus

Environment	Portal23Environment	PortalAuxiliary

Ak	Environemnts2Box	Collider1'z'RedBlue
IAk	Environment	Portal2

EnvironmentEnvironment	Portal	 AkEvironmentAkEvironmentPortal
Inspector	(Reverb	Zones) 	

Timeline

UnityTimelineAkEventTrackAkRTPCTrack2Cube

TimelineWindow->TimelineTimelineDemoTimeline	Demo
ButtonButtonCubeWwiseTimelineTimeline
TimelineButtonPlayable	Director

Timeline2Cube1Cubez
TimelineAkEventTrackAkRTPCTrackAkEventTrack2
AkEventPlayable1PlayCubeMovementWwise2PlayImpact
WwiseWwiseTimeline
PlayCubeMovementWwiseRTPCRTPC
CubeAccelerationCubeAkRTPCTrackRTPCCube

This	station	also	demonstrates	the	Motion	feature.	Note	that	there	is	a
game	object	called	"Motion	listener"	in	the	player	hierarchy.	This	game
object	set	up	the	output	for	the	Motion	device	on	supported	platforms.



Any	output	needs	a	set	of	listeners	to	receive	data.	That	is	why	the
Motion	listener	also	have	a	Ak	Game	Object	and	a	Ak	Audio	Listener.	To
enable	the	Motion	effect	on	the	cube	impact,	two	important	things	needs
to	be	done.	First,	the	impact	sound	needs	to	be	routed	to	an	output	bus
using	the	Wwise	Motion	ShareSet	in	the	Wwise	project.	Second,	the
listener	used	for	the	Motion	output	needs	to	be	added	to	the	listeners	of
the	emitter	posting	the	impact	event.	Inspect	the	AkMotionListener	script
for	an	example	on	how	to	add	an	output.

	To	support	the	Motion	feature	on	android,	the	manifest	of	the
application	must	include	the	vibration	permission.	Unity	generates
automatically	the	manifest	based	on	the	content	of	the	application.
Adding	a	call	to	Handheld.Vibrate()	will	add	the	desired	permission
in	the	manifest.

Timeline	 WwiseTimeline 	



Spatial	Audio	Scene
This	scene	is	the	final	product	of	the	Spatial	Audio	Tutorial.
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Using	UnityWwise	Spatial	Audio
UnitySpatial	Audio3:

:
Spatial	Audio

1.	Unity
2.	Wwise
3.	Unity

2:
Surface	Reflectors

:

	Wwise	Reflect
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Spatial	Audio
Surface	Reflectors 		 	:

1.	Unity
2.	Wwise
3.	Unity

3.A.	
3.B.	
3.C.	
3.D.	



1.	Unity
WwiseUnity

1.	 Unity
2.	 Unity
3.	 Wwise	Launcher UnityWwise

https://www.audiokinetic.com/library/edge/?source=InstallGuide&id=integrating_wwise_into_an_unreal_or_unity_project


2.	Wwise
SFX11SoundBank1

1.	 LauncherWwise
2.	 Actor	Mixer	HierarchyDefault	Work	UnitSFXWwise

1
1.	 1
2.	 Sound	Property	Editor

1.	 General	Settings Use	game-defined	auxiliary	sends

Sound	Property	EditorGeneral	Settings

2.	 Positioning 3DAttenuation



Sound	Property	EditorPositioning

3.	 Actor-Mixer	HierarchySFX New	Event	>	Play 	

Event	Editor

4.	 SoundBankF7SoundBankSoundBank
WwiseSoundBank	Manager:	



SoundBank	ManagerEditor

5.	



3.	Unity
112LauncherUnity
Wwise	Picker	(Windows	>	Wwise	Picker)Refresh	ProjectGenerate
SoundBanks

Wwise	Picker

3.A.	

1.	 Cube:	 GameObject	>	3D	Object	>	Cube
Object	Name Position Rotation Scale
Floor (0,	0,	0) (0,	0,	0) (50,	0.5,	50)
Wall	Front	Left (-4.5,	3,	-10) (0,	0,	0) (7,	6,	0.5)
Wall	Front	Middle (0,	5,	-10) (0,	0,	0) (2,	2,	0.5)
Wall	Front	Right (2.5,	3,	-10) (0,	0,	0) (3,	6,	0.5)
Wall	Left	Small (-7.75,	3,	-6) (0,	0,	0) (0.5,	6,	8)



Wall	Back	Small (-2,	3,	-2) (0,	0,	0) (12,	6,	0.5)
Ceiling	Small (-2,	5.75,	-6) (0,	0,	0) (12,	0.5,	8)
Wall	Right	Small (3.75,	3,	-8) (0,	0,	0) (0.5,	6,	3.5)
Wall	Front	Large (11.5,	3,	-7.5) (0,	0,	0) (16,	6,	0.5)
Wall	Right	Large (19.25,	3,	3.25) (0,	0,	0) (0.5,	6,	21.5)
Wall	Middle (3.75,	5,	-4.5) (0,	0,	0) (0.5,	2,	3.5)
Wall	Left	Large (3.75,	3,	5.625) (0,	0,	0) (0.5,	6,	16.75)
Wall	Back	Large (11.5,	3,	14) (0,	0,	0) (16,	6,	0.5)
Ceiling	Large (11.5,	5.75,	3.25) (0,	0,	0) (16,	0.5,	22)
Barrier (-4.5,	3,	-17) (0,	0,	0) (7,	6,	0.5)

2.	 	(	 GameObject	>	Light	>	Spotlight	)
Object	Name Position Rotation Scale
Spotlight	Small	Room (-3,	5.75,	-6) (0,	0,	0) (1,	1,	1)
Spotlight	Large	Room (11.5,	5.75,	5) (0,	0,	0) (1,	1,	1)
1.	 Light:

1.	 Range30
2.	 Spot	Angle179

3.B.	

Object	Name Position Rotation Scale
MainCharacter (0,	1.3,	-20) (0,	0,	0) (1,	1,	1)

1.	 Unity	Audio	Source
2.	 Ak	Audio	Listener

Ak	Audio	Listener	component

3.	 Ak	Spatial	Audio	Listener



Ak	Spatial	Audio	Listener	component

3.C.	

1.	 	(	 GameObject	>	3D	Object	>	Cylinder	)
Object	Name Position Rotation Scale
Button	Outside (-3,	0.75,	-15) (0,	0,	0) (0.15,	0.5,	0.15)
Button	Small	Room (-3,	0.75,	-5) (0,	0,	0) (0.15,	0.5,	0.15)
Button	Large	Room (7.5,	0.75,	5) (0,	0,	0) (0.15,	0.5,	0.15)

2.	 Ak	Spatial	Audio	Emitter

Ak	Spatial	Audio	Emitter

3.	 Ak	Game	Obj:
1.	 Environment	Aware
2.	 Use	Default	Listener



Ak	Game	Obj

4.	 Ak	Ambient:
1.	 Trigger	On
2.	 Play_sound Event	Name

Ak	Ambient

5.	 Ak	Bank:
1.	 2.	Wwise 	SoundBank Bank	Name

Ak	Bank



6.	 WwiseProfilerF6
7.	 Wwise
8.	 Voices	Graph

Button	Outside

3.D.	

1.	
2.	 Unity



Unity
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Surface	Reflectors
ReflectSpatial	AudioReflect

A.	Wwise
B.	Spatial	Audio
C.	Surface	Reflector

C.1.	
C.2.	:	

:		 Spatial	Audio 		 	



A.	Wwise
WwiseReflectAux

1.	 Auxiliary	BusMaster	Audio	Bus
1.	 Auxiliary	Bus	Property	Editor

1.	 EffectsWwise	Reflect

Auxiliary	Bus	Property	EditorEffectsReflect

2.	 Positioning2D



Auxiliary	Bus	Property	EditorPositioningReflect

2.	 Reflect	Acoustic	Textures:	Project	>	Import	Factory	Assets...
1.	 Project	Explorer ShareSets Virtual	Acoustics



Project	ExplorerShareSetsFactory	Reflect	Acoustic
Textures

2.	 Default	Work	UnitVirtual	Acoustics

3.	



B.	Spatial	Audio
Aux

1.	 Wwise	PickerWwise:	Windows	>	Wwise	Picker
1.	

Wwise	Picker

2.	 Ak	Spatial	Audio	Emitter
1.	 Reflect	Aux	BusReflect	Auxiliary	Bus
2.	 Reflections	Order2
3.	 Reflections	Aux	Bus	Gain1
4.	 Reflection	Max	Path	Length100000
5.	 Debug	DrawDraw	First	Order	ReflectionsDraw	Second

Order	Reflections



Surface	ReflectorAk	Spatial	Audio	Emitter



C.	Surface	Reflector
Ak	Surface	Reflector1

C.1.	

Spatial	Audio	API
11	Unity

1.	 	 3.A.		 Ak	Surface	Reflector1
1.	 Acoustic	Texture None

Ak	Surface	Reflector

2.	
1.	 	 Debug	Draw Scene

1Cube
122



2.	 Game Gizmos Debug	Draw
76



3.	 WwiseProfilerButton	Small	Room

ReflectButton	Small	Room



4.	 ReflectAuxEffectsReflectReflect
Effect	EditorDrywallTile
2

ReflectEffect	Editor

C.2.	:	

	
2	Cube
Quads

1.	 Cube:	GameObject	>	3D	Object	>	Cube
Object	Name Position Rotation Scale
Small	Room	Interior (-2,	2.875,	-6) (0,	0,	0) (11,	5.25,	7.5)

1.	 Mesh	Renderer
2.	 Box	Collider Is	Trigger
3.	 Ak	Surface	Reflector



1.	 Button	Small	RoomButton	Outside
Small	Room	Interior

2.	 Button	Small	RoomButton	Outside
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Spatial	Audio

A.	Wwise	Project
B.	Spatial	Audio	Emitter
C.	Rooms
D.	Portals
E.	
F.	

:		 Spatial	Audio 		 Surface	Reflectors
		 Surface	Reflectors 	

C.2.	:	 		 Surface	Reflectors 	
Ak	Surface	Reflector



A.	Wwise	Project
ReverbObstruction

1.	 Master	Audio	BusAuxiliary	Bus2SmallRoomLargeRoom
Auxiliary	Bus	Property	Editor

1.	 EffectsWwise	RoomVerb2SmallRoom
Rooms/Room_MediumLargeRoomCathedrals/Medium

Auxiliary	Bus	Property	EditorEffects

2.	 Positioning3D



Auxiliary	Bus	Property	EditorPositioning

2.	 Project	>	Project	Settings	>	Obstruction/Occlusion
1.	 :

Curve Point	1
X Y

Obstruction	Volume 0 0
Obstruction	LPF 0 0

2.	 Obstruction	Volume:



Wwise	Project	SettingsObstruction/Occlusion

3.	



B.	Spatial	Audio	Emitter
Aux

1.	 Wwise	PickerWwise:	Windows	>	Wwise	Picker
1.	

Wwise	Picker

2.	 Ak	Spatial	Audio	Emitter
1.	 Room	Reverb	Aux	Bus	Gain1
2.	 Debug	DrawDraw	Sound	Propagation



RoomPortalAk	Spatial	Audio	Emitter

3.	 Ak	Game	ObjRigidbody
1.	 Add	Rigidbody

Ak	Game	Obj



C.	Rooms
Ak	Room

1.	 Cube:	GameObject	>	3D	Object	>	Cube
Object	Name Position Rotation

Small	Room	Interior (-2,	2.875,	-6) (0,	0,	0)
Large	Room	Interior (11.5,	2.875,	3.25) (0,	0,	0)
1.	 Mesh	Renderer
2.	 Box	Collider Is	Trigger
3.	 Small	RoomLarge	RoomInterior	Volume Ak	Room

1.	 Reverb	Aux	BusSmallRoomLargeRoomAux
2.	 RigidbodyAdd	Rigidbody

Ak	Room

2.	 WwiseGame	Object	Profiler
1.	
2.	 Game	Object	3D	Viewer

Button	Outside"Outdoors"
Ak	Spatial	Audio	Listener3.B



3.	 1Game	Object	3D	Viewer



Large	Room	Interior

3.	 1
1.	 :



Button	Small	RoomVoice	Graph

2.	

	Small	Room	InteriorLarge	Room
Interior



D.	Portals
222

1.	 Ak	Room	Portal2:	GameObject	>	Wwise	>	Room	Portal
Object	Name Position Rotation

Outside	Portal (0,	2,	-10) (0,	0,	0)
Inside	Portal (3.75,	2,	-4.5) (0,	90,	0)

2.	 Ak	Room	Portal:
1.	 Open	On	Start.
2.	 Close	On	Nothing.
3.	 Back	RoomFront	RoomAk	Room

3.	 InsideAk	Room	Portal:

Ak	Room	Portal

4.	 SceneZ



SceneAk	Room

5.	 Draw	Sound	Propagation
wet	diffractiondry
diffraction

1.	 Wwise



2.	 Button	Outside
1.	 Sound	Propagation

Small	Room	InteriorButton	OutsideSound
Propagation

2.	
Button	OutsideGame	Object	3D	Viewer
Outside	PortalSmall	Room	Interior
OutsideSmall	Room	Interior
Button	OutsideDiffraction
angle103.3Button	Outside



Portal	diffraction	angle	on	Game	Object	3D	Viewer

Note:	At	this	point,	if	you	change	the	position	of	the	rooms
or	multi-edit	portals,	the	front	and	back	rooms	will	not
update,	unless	you	open	each	individual	AkRoomPortal
inspector.	In	a	scene	with	a	lot	of	portals,	this	is	not
convenient,	so	you	can	use	the	AkRoomPortal	Baker
window	we	added	as	an	example	in	this	tutorial.	Open	the
window	from	the	menu:	Wwise	>	AkRoomPortal	Baker...
Click	the	bake	button	to	update	the	front	and	back	rooms	of
all	the	portals	in	the	scene.



E.	

1.	 SmallRoom	Auxiliary	BusProperty	EditorGeneral	Settings Use
game-defined	auxiliary	sends

Auxiliary	Bus	Property	EditorGeneral	Settings

2.	



Voices	GraphButton	Small	RoomLarge	Room	Interior



F.	

1.	 	 Surface	Reflectors 	
1.	 ReflectAuxiliary	Bus
2.	 Ak	Spatial	Audio	EmitterReflect	Auxiliary	Bus
3.	 Ak	Surface	Reflector

2.	 WwiseReflectAuxiliary	Bus
1.	 General	Settings Use	game-defined	auxiliary	sends

Auxiliary	Bus	Property	EditorGeneral	Settings

3.	 Voices	Graph:



Voices	Graph
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Unity:

A.	
B.	



A.	
Ak	Emitter	Obstruction	OcclusionUnity

	
Obstruction	Occlusion	

Ak	Spatial	Audio	Listener

1.	 Ak	Emitter	Obstruction	OcclusionButton	Outside
1.	 Layer	MaskIn	the	SpatialAudioTutorial	scene

provided	with	the	integration,	we	have	put	the	first	person
character	on	a	user	created	layer	called	"Player"	and	the
GameObjects	with	AkRoom	or	AkRoomPortal	components	on
a	user	created	layer	called	"Ignore	Audio	Raycast".	 Layer
Mask

Ak	Emitter	Obstruction	Occlusion

Ak	Emitter	Obstruction	OcclusionLayer	Mask



2.	
1.	 Button	Outside
2.	 Barrier Ak	Room



B.	
Ak	Room	Portal Ak	Room	Portal

Obstruction		 	

1.	 Ak	Room	Portal	ObstructionOutside	Portal
1.	 Layer	MaskIn	the	SpatialAudioTutorial	scene

provided	with	the	integration,	we	have	put	the	the	GameObjects
with	AkRoom	components	on	a	user	created	layer	called
"Ignore	Audio	Raycast".	 Layer	Mask

Ak	Room	Portal	Obstruction

Ak	Room	Portal	ObstructionLayer	Mask

2.	
1.	 Button	Small	Room
2.	 Barrier



Wwise	Unity	IntegrationThu	Feb	1	09:40:26	2018		 	1.6.3

http://www.doxygen.org/index.html


Wwise	Unity	Integration



UnityDllNotFoundException	console

Wwise	Profiler
Error	during	installation	-	Unity
Wwise	for	MacSoundBank	-	Wwise_IDs.h
Error:	Plugin
MacUnity	Console"Multiple	plugins	with	the	same	name"	
Xbox	One"Failed	to	initialize	the	sound	engine"-in



Wwise2013.2.8
UNITY_PROJECT_ROOT\Assets\Wwise\Deployment\Examples 	Components	

Examples

UnityPackageorms.	



UnityDllNotFoundException	console
WindowsAkSoundEngineDllNotFoundExceptionUnity2

DirectX
Wwise-Unity	IntegrationDebug Microsoft	Visual	Studio
2010	Debug	Redistributables



:

WindowsMacEditorEditor
SoundBankUnityEditorWwiseGenerated
SoundbanksSoundBank1StreamingAssetsWwise
SoundBank
Sound	EngineScript	Execution	Order	(menu
Edit	>	Project	Settings	>	Script	Execution	Order)AkInitializer
AkTerminator
Unity...
Wwise	ProfilerWwiseF7Capture	Log
Wwise	ProfilerSoundBankProfiling	Settings	(Alt-G)
SoundBankAkBank

Wwise	ProfilerCapture	LogEventSoundBank
AkEvent,	AkAmbient



Wwise	Profiler
Windows

background		 Run	Unity 	(menu	File	>	Build	Settings	>	Player
Settings)
port	24024Wwise
Wwise-Unity	Plug-in	 Debug	
Profile	
Task	Manager"adb.exe"AndroidTCPAndroid
AndroidGoogle

WwiseRemote	Connection Connect	To	IP
IP

port	24024



Error	during	installation	-	Unity
Wwise:	Error	during	installation:	Access	to	the	path	is	deniedUnity
:

Plug-in	( Debug,	Profile,	Release)	 Assets	>	Wwise	>
Install	Plugins	

Unity	IntegrationWwise	Setup
Unity	EditorScene

UnityPlug-in	( Debug,	Profile,	Release)	



Wwise	for	MacSoundBank	-	Wwise_IDs.h
Wwise	for	MacSoundBankWwise_IDs.h:

Wwise	Project
Project	SettingsSoundBanks
Header	file	pathSoundBanks



Error:	Plugin
WwiseAkSoundEngine 	



MacUnity	Console"Multiple	plugins	with	the
same	name"	
Mac		Unity	IntegrationUnity	Console

Multiple	plug-ins	with	the	same	name	'aksoundengine'	(found	at
'Assets/Wwise/Deployment/Plugins/Mac/Release/AkSoundEngine.bundle'
and
'Assets/Wwise/Deployment/Plugins/Mac/Debug/AkSoundEngine.bundle').
Editor11Editor



Xbox	One"Failed	to	initialize	the	sound
engine"-in
Xbox	OneUnityWwiseAssets	>
Project	Settings	>	Audio"Disable	audio"

Unity	5.0.2"Disable	audio"
AkInitializer.cs:

				AkPlatformInitSettings	platformSettings	=	new	Ak

PlatformInitSettings();

				AkSoundEngine.GetDefaultPlatformInitSettings(pla

tformSettings);

				platformSettings.uLEngineDefaultPoolSize	=	(uint

)lowerPoolSize	*	1024;

				platformSettings.fLEngineDefaultPoolRatioThresho

ld	=	memoryCutoffThreshold;

				AkPlatformInitSettings	platformSettings	=	new	Ak

PlatformInitSettings();

				AkSoundEngine.GetDefaultPlatformInitSettings(pla

tformSettings);

				platformSettings.uLEngineDefaultPoolSize	=	(uint

)lowerPoolSize	*	1024;

				platformSettings.fLEngineDefaultPoolRatioThresho

ld	=	memoryCutoffThreshold;

#if	UNITY_XBOXONE	&&	!UNITY_EDITOR

								platformSettings.uMaxXMAVoices	=	0;

#endif

XMA
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Licensing	(Free	&	Commercial)
Wwise	licenses	are	required	for	any	games	that	are	released	publicly.	
1Audiokinetic

Free	Limited	Commercial	License
Educational	&	Non	Commercial	License
Royalty-based	License
Commercial	License
Licensing	FAQ
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AK::Wwise::AcousticTexture

AK::Wwise::AuxBus

AK::Wwise::Bank

AK::Wwise::BaseGroupType

AK::Wwise::BaseType

AK::Wwise::CallbackFlags

AK::Wwise::Event

AK::Wwise::RTPC

AK::Wwise::State

AK::Wwise::Switch



AK::Wwise::Trigger

AkAmbient

AkAudioListener



AkBank

AkCallbackManager

AkEmitterObstructionOcclusion

AkEnvironment

AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm



AkEnvironmentPortal

AkEvent

AkEventCallbackMsg

AkGameObj



AkInitializer
AkMemBankLoader

AkRoom

AkRoomPortal

AkRoomPortalObstruction

AkSpatialAudioEmitter



AkSpatialAudioListener

AkState

AkSurfaceReflector

AkSwitch

AkTerminator
AkTriggerBase
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	AK::Wwise::AcousticTexture
This	type	represents	an	Acoustic	Texture.	[]

AK::Wwise::AcousticTexture



This	type	represents	an	Acoustic	Texture.
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	AK::Wwise::AuxBus
This	type	represents	an	auxiliary	send	in	the	Master-Mixer	Hierarchy.	[
]

AK::Wwise::AuxBus



This	type	represents	an	auxiliary	send	in	the	Master-Mixer	Hierarchy.

Wwise	Unity	IntegrationThu	Feb	1	09:40:26	2018		 	1.6.3

http://www.doxygen.org/index.html


AK::Wwise::Bank



	AK::Wwise::Bank
This	type	can	be	used	to	load/unload	SoundBanks.	[]

AK::Wwise::Bank



This	type	can	be	used	to	load/unload	SoundBanks.
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	AK::Wwise::BaseGroupType
This	type	represents	the	base	for	all	Wwise	Types	that	also	require	a
group	GUID,	such	as	State	and	Switch.	[]

AK::Wwise::BaseGroupType



This	type	represents	the	base	for	all	Wwise	Types	that	also	require	a
group	GUID,	such	as	State	and	Switch.
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	AK::Wwise::BaseType
This	type	represents	the	base	for	all	Wwise	Types	that	require	a	GUID.
[]

AK::Wwise::BaseType



This	type	represents	the	base	for	all	Wwise	Types	that	require	a	GUID.
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AK::Wwise::CallbackFlags



	AK::Wwise::CallbackFlags
This	type	represents	the	values	of	the	flags	used	when	posting	an	Event
with	a	callback.	[]



This	type	represents	the	values	of	the	flags	used	when	posting	an	Event
with	a	callback.
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AK::Wwise::Event



	AK::Wwise::Event
This	type	can	be	used	to	post	Events	to	the	sound	engine.	[]

AK::Wwise::Event



Public	

uint	 Post	(GameObject	gameObject)
	 Posts	this	Event	on	a	GameObject.	

uint	 Post	(GameObject	gameObject,	CallbackFlags	flags,AkCallbackManager.EventCallback	callback,	object	cookie=null)
	 Posts	this	Event	on	a	GameObject.	

uint	 Post	(GameObject	gameObject,	uint	flags,AkCallbackManager.EventCallback	callback,	object	cookie=null)
	 Posts	this	Event	on	a	GameObject.	

void	
ExecuteAction	(GameObject	gameObject,
AkActionOnEventType	actionOnEventType,	int	transitionDuration,
AkCurveInterpolation	curveInterpolation)

	 Executes	various	actions	on	this	event	associated	with	a
GameObject.	

void	 PostMIDI	(GameObject	gameObject,	AkMIDIPostArray	array)
	 Posts	MIDI	Events	on	this	Event	associated	with	a	GameObject.	

void	 PostMIDI	(GameObject	gameObject,	AkMIDIPostArray	array,	intcount)
	 Posts	MIDI	Events	on	this	Event	associated	with	a	GameObject.	
void	 StopMIDI	(GameObject	gameObject)
	 Stops	MIDI	Events	on	this	Event	associated	with	a	GameObject.
void	 StopMIDI	()
	 Stops	all	MIDI	Events	on	this	Event.	



This	type	can	be	used	to	post	Events	to	the	sound	engine.

Wwise	Unity	IntegrationThu	Feb	1	09:40:26	2018		 	1.6.3

http://www.doxygen.org/index.html


AK::Wwise::RTPC



	AK::Wwise::RTPC
This	type	can	be	used	to	set	game	parameter	values	to	the	sound
engine.	[]

AK::Wwise::RTPC



This	type	can	be	used	to	set	game	parameter	values	to	the	sound
engine.
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AK::Wwise::State



	AK::Wwise::State
This	type	can	be	used	to	set	Wwise	States.	[]

AK::Wwise::State



This	type	can	be	used	to	set	Wwise	States.
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AK::Wwise::Switch



	AK::Wwise::Switch
This	type	can	be	used	to	set	Switch	values	on	gameobjects.	[]

AK::Wwise::Switch



This	type	can	be	used	to	set	Switch	values	on	gameobjects.

Wwise	Unity	IntegrationThu	Feb	1	09:40:26	2018		 	1.6.3

http://www.doxygen.org/index.html


AK::Wwise::Trigger



	AK::Wwise::Trigger
This	type	can	be	used	to	post	triggers	to	the	sound	engine.	[]

AK::Wwise::Trigger



This	type	can	be	used	to	post	triggers	to	the	sound	engine.
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	AkAmbient
Use	this	component	to	attach	a	Wwise	Event	to	any	object	in	a	scene.
The	sound	can	be	started	at	various	moments,	dependent	on	the
selected	Unity	trigger.	This	component	is	more	useful	for	ambient	sounds
(sounds	related	to	scene-bound	objects)	but	could	also	be	used	for	other
purposes.	Since	AkAmbient	has	AkEvent	as	its	base	class,	it	features
the	play/stop,	play	multiple,	stop	multiple	and	stop	all	buttons	for
previewing	the	associated	Wwise	event.	[]

AkAmbient



Public	

int	 eventID	=	0
	 ID	of	the	Event	as	found	in	the	WwiseID.cs	file.	

GameObject	 soundEmitterObject	=	null

	
Game	object	onto	which	the	Event	will	be	posted.
By	default,	when	empty,	it	is	posted	on	the	same
object	on	which	the	component	was	added.	

bool	 enableActionOnEvent	=	false

	

Enables	additional	options	to	reuse	existing
events.	Use	it	to	transform	a	Play	event	into	a	Stop
event	without	having	to	define	one	in	the	Wwise
Project.	

AkActionOnEventType	 actionOnEventType	=AkActionOnEventType.AkActionOnEventType_Stop

	 Replacement	action.	See
AK::SoundEngine::ExecuteEventOnAction().	

AkCurveInterpolation	 curveInterpolation	=AkCurveInterpolation.AkCurveInterpolation_Linear

	 Fade	curve	to	use	with	the	new	Action.	See
AK::SoundEngine::ExecuteEventOnAction().	

float	 transitionDuration	=	0.0f

	 Duration	of	the	fade.	See
AK::SoundEngine::ExecuteEventOnAction().	

const	int	 MAX_NB_TRIGGERS	=	32

	 Since	our	mask	is	a	32	bits	integer,	we	can't	have
more	than	32	triggers.	

List<	int	>	 triggerList	=	new	List<int>()	{START_TRIGGER_ID	}
	 List	containing	the	enabled	triggers.	

bool	 useOtherObject	=	false

	

This	property	is	usefull	only	when	used	with
colliders.	When	enabled,	the	target	of	the	action



will	be	the	other	colliding	object.	When	disabled,	it
will	be	the	current	object.	



Static	Public	

static	Dictionary<	uint,	string	>	 triggerTypes	=AkTriggerBase.GetAllDerivedTypes	()

	
Will	contain	the	types	of	all	the	triggers
derived	from	AkTriggerBase	at
runtime.	



Use	this	component	to	attach	a	Wwise	Event	to	any	object	in	a	scene.
The	sound	can	be	started	at	various	moments,	dependent	on	the
selected	Unity	trigger.	This	component	is	more	useful	for	ambient	sounds
(sounds	related	to	scene-bound	objects)	but	could	also	be	used	for	other
purposes.	Since	AkAmbient	has	AkEvent	as	its	base	class,	it	features
the	play/stop,	play	multiple,	stop	multiple	and	stop	all	buttons	for
previewing	the	associated	Wwise	event.

:
AkAmbientInspector
AkGameObj
AkEvent
Integration	Details	-	Events	(Note:	This	is	described	in	the
Wwise	SDK	documentation.)
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	AkAudioListener
Add	this	script	on	the	game	object	that	represent	a	listener.	This	is
normally	added	to	the	Camera	object	or	the	Player	object,	but	can	be
added	to	any	game	object	when	implementing	3D	busses.
isDefaultListener	determines	whether	the	game	object	will	be
considered	a	default	listener	-	a	listener	that	automatically	listens	to	all
game	objects	that	do	not	have	listeners	attached	to	their
AkGameObjListenerList's.	[]



Add	this	script	on	the	game	object	that	represent	a	listener.	This	is
normally	added	to	the	Camera	object	or	the	Player	object,	but	can	be
added	to	any	game	object	when	implementing	3D	busses.
isDefaultListener	determines	whether	the	game	object	will	be
considered	a	default	listener	-	a	listener	that	automatically	listens	to	all
game	objects	that	do	not	have	listeners	attached	to	their
AkGameObjListenerList's.

:
Integrating	Listeners	(Note:	This	is	described	in	the	Wwise	SDK
documentation.)
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	AkBank
Loads	and	unloads	a	SoundBank	at	a	specified	moment.	Vorbis	sounds
can	be	decompressed	at	a	specified	moment	using	the	decode
compressed	data	option.	In	that	case,	the	SoundBank	will	be	prepared.
[]

AkUnityEventHandler



Public	

override	void	 HandleEvent	(GameObject	in_gameObject)
	 Loads	the	SoundBank.	

void	 UnloadBank	(GameObject	in_gameObject)
	 Unloads	a	SoundBank.	



Public	

string	 bankName	=	""
	 Name	of	the	SoundBank,	as	specified	in	the	Wwise	project.

bool	 loadAsynchronous	=	false

	
Check	this	to	load	the	SoundBank	in	the	background.	Be
careful,	if	Events	are	triggered	and	the	SoundBank	hasn't
finished	loading,	you'll	have	"Event	not	found"	errors.	

bool	 decodeBank	=	false
	 Decode	this	SoundBank	upon	load.	

bool	 saveDecodedBank	=	false

	 Save	the	decoded	SoundBank	to	disk	for	faster	loads	in	the
future.	

List<	int	>	 unloadTriggerList	=	new	List<int>(){AkUnityEventHandler.DESTROY_TRIGGER_ID	}
	 Reserved.	
const	int	 MAX_NB_TRIGGERS	=	32

	 Since	our	mask	is	a	32	bits	integer,	we	can't	have	more
than	32	triggers.	

List<	int	>	 triggerList	=	new	List<int>()	{	START_TRIGGER_ID	}
	 List	containing	the	enabled	triggers.	

bool	 useOtherObject	=	false

	
This	property	is	usefull	only	when	used	with	colliders.
When	enabled,	the	target	of	the	action	will	be	the	other
colliding	object.	When	disabled,	it	will	be	the	current	object.



Static	Public	

static	Dictionary<	uint,	string	>	 triggerTypes	=AkTriggerBase.GetAllDerivedTypes	()

	
Will	contain	the	types	of	all	the	triggers
derived	from	AkTriggerBase	at
runtime.	



Loads	and	unloads	a	SoundBank	at	a	specified	moment.	Vorbis	sounds
can	be	decompressed	at	a	specified	moment	using	the	decode
compressed	data	option.	In	that	case,	the	SoundBank	will	be	prepared.
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	AkCallbackManager
This	class	manages	the	callback	queue.	All	callbacks	from	the	native
Wwise	SDK	go	through	this	queue.	The	queue	needs	to	be	driven	by
regular	calls	to	PostCallbacks().	This	is	currently	done	in	AkInitializer.cs,
in	LateUpdate().	[]



Static	Public	

static	void	 SetMonitoringCallback	(AkMonitorErrorLevel	in_Level,MonitoringCallback	in_CB)

	 Call	this	to	set	a	function	to	call	whenever	Wwise	prints	a
message	(warnings	or	errors).	

static	void	 SetBGMCallback	(BGMCallback	in_CB,	object	in_cookie)
static	int	 PostCallbacks	()



This	class	manages	the	callback	queue.	All	callbacks	from	the	native
Wwise	SDK	go	through	this	queue.	The	queue	needs	to	be	driven	by
regular	calls	to	PostCallbacks().	This	is	currently	done	in	AkInitializer.cs,
in	LateUpdate().
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	AkEmitterObstructionOcclusion
Obstructs/Occludes	the	emitter	of	the	current	game	object	from	its
listeners	if	at	least	one	object	is	between	them.	[]

AkObstructionOcclusion



Public	

LayerMask	 LayerMask	=	-1
	 Indicates	which	layers	act	as	obstructers/occluders.	

float	 refreshInterval	=	1

	 The	number	of	seconds	between	obstruction/occlusion
checks.	

float	 fadeTime	=	0.5f
	 The	number	of	seconds	for	fade	ins	and	fade	outs.	

float	 maxDistance	=	-1.0f

	
The	maximum	distance	at	which	to	perform
obstruction/occlusion.	A	negative	value	will	be	interpreted
as	inifinite	distance.	



Obstructs/Occludes	the	emitter	of	the	current	game	object	from	its
listeners	if	at	least	one	object	is	between	them.

The	current	implementation	does	not	support	occlusion.
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	AkEnvironment
Use	this	component	to	define	a	reverb	zone.	This	needs	to	be	added	to	a
collider	object	to	work	properly.	AkEvironmentAkEvironmentPortal
Inspector	(Reverb	Zones) .	[]



class		 AkEnvironment_CompareBySelectionAlgorithm



Use	this	component	to	define	a	reverb	zone.	This	needs	to	be	added	to	a
collider	object	to	work	properly.	AkEvironmentAkEvironmentPortal
Inspector	(Reverb	Zones) .

This	component	can	be	attached	to	any	collider.	You	can	specify	a	roll-off
to	fade-in/out	of	the	reverb.	The	reverb	parameters	will	be	defined	in	the
Wwise	project,	by	the	sound	designer.	All	AkGameObj	that	are
"environment"-aware	will	receive	a	send	value	when	entering	the
attached	collider.

:
AkEvironmentAkEvironmentPortalInspector	(Reverb
Zones)
Integrating	Environments	and	Game-defined	Auxiliary	Sends
(Note:	This	is	described	in	the	Wwise	SDK	documentation.)
AK::SoundEngine::SetGameObjectAuxSendValues	(Note:	This
is	described	in	the	Wwise	SDK	documentation.)
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AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm



AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm
AkEnvironment::AkEnvironment_CompareByPriority



The	selection	algorithm	is	as	follow:

1.	 Environments	have	priorities.
2.	 Environments	have	a	"Default"	flag.	This	flag	effectively	says	that

this	environment	will	be	bumped	out	if	any	other	is	present.
3.	 Environments	have	an	"Exclude	Other"	flag.	This	flag	will	tell	that	this

env	is	not	overlappable	with	others.	So,	only	one	(the	highest
priority)	should	be	selected.

Wwise	Unity	IntegrationThu	Feb	1	09:40:26	2018		 	1.6.3

http://www.doxygen.org/index.html




	AkEnvironmentPortal
Use	this	component	to	define	an	area	that	straddles	two	different
AkEnvironments	zones	and	allow	mixing	between	both	zones.
AkEvironmentAkEvironmentPortalInspector	(Reverb	Zones) .	[]



Public	

float	 GetAuxSendValueForPosition	(Vector3	in_position,	int	index)
	 The	axis	used	to	find	the	contribution	of	each	environment.	



Public	

Vector3	 axis	=	new	Vector3(1,0,0)



Use	this	component	to	define	an	area	that	straddles	two	different
AkEnvironments	zones	and	allow	mixing	between	both	zones.
AkEvironmentAkEvironmentPortalInspector	(Reverb	Zones) .
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	AkEvent
Helper	class	that	knows	a	Wwise	Event	and	when	to	trigger	it	in	Unity.	As
of	2017.2.0,	the	AkEvent	inspector	has	buttons	for	play/stop,	play
multiple,	stop	multiple,	and	stop	all.	Play/Stop	will	play	or	stop	the	event
such	that	it	can	be	previewed	both	in	edit	mode	and	play	mode.	When
multiple	objects	are	selected,	Play	Multiple	and	Stop	Multiple	will	play	or
stop	the	associated	AkEvent	for	each	object.	[]

AkEvent



Public	

int	 eventID	=	0
	 ID	of	the	Event	as	found	in	the	WwiseID.cs	file.	

GameObject	 soundEmitterObject	=	null

	
Game	object	onto	which	the	Event	will	be	posted.
By	default,	when	empty,	it	is	posted	on	the	same
object	on	which	the	component	was	added.	

bool	 enableActionOnEvent	=	false

	

Enables	additional	options	to	reuse	existing
events.	Use	it	to	transform	a	Play	event	into	a	Stop
event	without	having	to	define	one	in	the	Wwise
Project.	

AkActionOnEventType	 actionOnEventType	=AkActionOnEventType.AkActionOnEventType_Stop

	 Replacement	action.	See
AK::SoundEngine::ExecuteEventOnAction().	

AkCurveInterpolation	 curveInterpolation	=AkCurveInterpolation.AkCurveInterpolation_Linear

	 Fade	curve	to	use	with	the	new	Action.	See
AK::SoundEngine::ExecuteEventOnAction().	

float	 transitionDuration	=	0.0f

	 Duration	of	the	fade.	See
AK::SoundEngine::ExecuteEventOnAction().	

const	int	 MAX_NB_TRIGGERS	=	32

	 Since	our	mask	is	a	32	bits	integer,	we	can't	have
more	than	32	triggers.	

List<	int	>	 triggerList	=	new	List<int>()	{START_TRIGGER_ID	}
	 List	containing	the	enabled	triggers.	

bool	 useOtherObject	=	false

	

This	property	is	usefull	only	when	used	with
colliders.	When	enabled,	the	target	of	the	action



will	be	the	other	colliding	object.	When	disabled,	it
will	be	the	current	object.	



Static	Public	

static	Dictionary<	uint,	string	>	 triggerTypes	=AkTriggerBase.GetAllDerivedTypes	()

	
Will	contain	the	types	of	all	the	triggers
derived	from	AkTriggerBase	at
runtime.	



Helper	class	that	knows	a	Wwise	Event	and	when	to	trigger	it	in	Unity.	As
of	2017.2.0,	the	AkEvent	inspector	has	buttons	for	play/stop,	play
multiple,	stop	multiple,	and	stop	all.	Play/Stop	will	play	or	stop	the	event
such	that	it	can	be	previewed	both	in	edit	mode	and	play	mode.	When
multiple	objects	are	selected,	Play	Multiple	and	Stop	Multiple	will	play	or
stop	the	associated	AkEvent	for	each	object.

:
Edit	Mode
AkAmbientInspector
Integration	Details	-	Events	(Note:	This	is	described	in	the
Wwise	SDK	documentation.)
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	AkEventCallbackMsg
Event	callback	information.	Event	callback	functions	can	receive	this
structure	as	a	parameter.	[]



Public	

GameObject	 sender

	 AkSoundEngine.PostEvent	callback	flags.	See	the
AkCallbackType	enumeration	for	a	list	of	all	callbacks.

AkCallbackInfo	 info

	 GameObject	from	whom	the	callback	function	was
called.	



Event	callback	information.	Event	callback	functions	can	receive	this
structure	as	a	parameter.
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	AkGameObj
This	component	represents	a	sound	object	in	your	scene	tracking	its
position	and	other	game	syncs	such	as	Switches,	RTPC	and
environment	values.	You	can	add	this	to	any	object	that	will	emit	sound,
and	it	will	be	added	to	any	object	that	an	AkAudioListener	is	attached
to.	Note	that	if	it	is	not	present,	Wwise	will	add	it	automatically,	with	the
default	values,	to	any	Unity	Game	Object	that	is	passed	to	Wwise.	[]



Public	

bool	 AddListener	(AkAudioListener	listener)

	 Adds	an	AkAudioListener	to	the	container	of	listeners
listening	to	this	gameobject.	

bool	 RemoveListener	(AkAudioListener	listener)

	 Removes	an	AkAudioListener	from	the	container	of
listeners	listening	to	this	gameobject.	

virtual	Vector3	 GetPosition	()
virtual	Vector3	 GetForward	()
virtual	Vector3	 GetUpward	()



Public	

AkGameObjPositionOffsetData	 m_positionOffsetData	=	null

	
When	not	set	to	null,	the	position	will
be	offset	relative	to	the	Game	Object
position	by	the	Position	Offset.	

bool	 isEnvironmentAware	=	true

	

Is	this	object	affected	by	Environment
changes?	Set	to	false	if	not	affected	in
order	to	save	some	useless	calls.
Default	is	true.	



This	component	represents	a	sound	object	in	your	scene	tracking	its
position	and	other	game	syncs	such	as	Switches,	RTPC	and
environment	values.	You	can	add	this	to	any	object	that	will	emit	sound,
and	it	will	be	added	to	any	object	that	an	AkAudioListener	is	attached
to.	Note	that	if	it	is	not	present,	Wwise	will	add	it	automatically,	with	the
default	values,	to	any	Unity	Game	Object	that	is	passed	to	Wwise.

:
Integration	Details	-	Game	Objects	(Note:	This	is	described	in
the	Wwise	SDK	documentation.)
Integration	Details	-	Events	(Note:	This	is	described	in	the
Wwise	SDK	documentation.)
Integrating	Listeners	(Note:	This	is	described	in	the	Wwise	SDK
documentation.)
Integration	Details	-	Switches	(Note:	This	is	described	in	the
Wwise	SDK	documentation.)
Integration	Details	-	States	(Note:	This	is	described	in	the	Wwise
SDK	documentation.)
Integration	Details	-	Environments	and	Game-defined	Auxiliary
Sends	(Note:	This	is	described	in	the	Wwise	SDK
documentation.)
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	AkInitializer



Public	

string	 basePath	=	AkSoundEngineController.s_DefaultBasePath

	 Path	for	the	soundbanks.	This	must	contain	one	sub	folder
per	platform,	with	the	same	as	in	the	Wwise	project.	

string	 language	=	AkSoundEngineController.s_Language
	 Language	sub-folder.	

int	 defaultPoolSize	=AkSoundEngineController.s_DefaultPoolSize

	
Default	Pool	size.	This	contains	the	meta	data	for	your	audio
project.	Default	size	is	4	MB,	but	you	should	adjust	for	your
needs.	

int	 lowerPoolSize	=	AkSoundEngineController.s_LowerPoolSize

	
Lower	Pool	size.	This	contains	the	audio	processing	buffers
and	DSP	data.	Default	size	is	2	MB,	but	you	should	adjust
for	your	needs.	

int	 streamingPoolSize	=
AkSoundEngineController.s_StreamingPoolSize

	 Streaming	Pool	size.	This	contains	the	streaming	buffers.
Default	size	is	1	MB,	but	you	should	adjust	for	your	needs.	

int	 preparePoolSize	=AkSoundEngineController.s_PreparePoolSize

	
Prepare	Pool	size.	This	contains	the	banks	loaded	using
PrepareBank	(Banks	decoded	on	load	use	this).	Default	size
is	0	MB,	but	you	should	adjust	for	your	needs.	

float	 memoryCutoffThreshold	=
AkSoundEngineController.s_MemoryCutoffThreshold

	
This	setting	will	trigger	the	killing	of	sounds	when	the
memory	is	reaching	95%	of	capacity.	Lowest	priority	sounds
are	killed.	

int	 monitorPoolSize	=
AkSoundEngineController.s_MonitorPoolSize

	 Monitor	Pool	size.	Size	of	the	monitoring	pool,	in	bytes.	This
parameter	is	not	used	in	Release	build.	



int	 monitorQueuePoolSize	=
AkSoundEngineController.s_MonitorQueuePoolSize

	 Monitor	Queue	Pool	size.	Size	of	the	monitoring	queue	pool,
in	bytes.	This	parameter	is	not	used	in	Release	build.	

int	 callbackManagerBufferSize	=AkSoundEngineController.s_CallbackManagerBufferSize

	
CallbackManager	buffer	size.	The	size	of	the	buffer	used
per-frame	to	transfer	callback	data.	Default	size	is	4	KB,	but
you	should	increase	this,	if	required.	

int	 spatialAudioPoolSize	=AkSoundEngineController.s_SpatialAudioPoolSize

	 Spatial	Audio	Lower	Pool	size.	Default	size	is	4	MB,	but	you
should	adjust	for	your	needs.	

uint	 maxSoundPropagationDepth	=
AkSoundEngine.AK_MAX_SOUND_PROPAGATION_DEPTH

	

Spatial	Audio	Max	Sound	Propagation	Depth.	Maximum
number	of	rooms	that	sound	can	propagate	through;	must	be
less	than	or	equal	to
AK_MAX_SOUND_PROPAGATION_DEPTH.	

AkDiffractionFlags	 diffractionFlags	=	AkDiffractionFlags.DefaultDiffractionFlags

	 Enable	or	disable	specific	diffraction	features.	See
AkDiffractionFlags.	

bool	 engineLogging	=AkSoundEngineController.s_EngineLogging

	 Enable	Wwise	engine	logging.	Option	to	turn	on/off	the
logging	of	the	Wwise	engine.	



This	script	deals	with	initialization,	and	frame	updates	of	the	Wwise	audio
engine.	It	is	marked	as	DontDestroyOnLoad	so	it	stays	active	for	the	life	of
the	game,	not	only	one	scene.	You	can,	and	probably	should,	modify	this
script	to	change	the	initialization	parameters	for	the	sound	engine.	A	few
are	already	exposed	in	the	property	inspector.	It	must	be	present	on	one
Game	Object	at	the	beginning	of	the	game	to	initialize	the	audio	properly.
It	must	be	executed	BEFORE	any	other	MonoBehaviors	that	use
AkSoundEngine.

:
Initialize	the	Different	Modules	of	the	Sound	Engine	(Note:	This
is	described	in	the	Wwise	SDK	documentation.)
AK::SoundEngine::Init()	(Note:	This	is	described	in	the	Wwise
SDK	documentation.)
AK::SoundEngine::Term()	(Note:	This	is	described	in	the	Wwise
SDK	documentation.)
AkCallbackManager
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	AkMemBankLoader



Public	

void	 LoadNonLocalizedBank	(string	in_bankFilename)
	 Load	a	sound	bank	from	WWW	object.	
void	 LoadLocalizedBank	(string	in_bankFilename)
	 Load	a	language-specific	bank	from	WWW	object.	



Public	

string	 bankName	=	""
	 Name	of	the	bank	to	load.	
bool	 isLocalizedBank	=	false

	 Is	the	bank	localized	(situated	in	the	language	specific	folders).	



This	class	is	an	example	of	how	to	load	banks	in	Wwise,	if	the	bank	data
was	preloaded	in	memory.	This	would	be	useful	for	situations	where	you
use	the	WWW	class
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	AkRoom
An	AkRoom	is	an	enclosed	environment	that	can	only	communicate	to
the	outside/other	rooms	with	AkRoomPortals.	[]



Public	

ulong	 GetID	()
	 Access	the	room's	ID.	



Public	

AK.Wwise.AuxBus	 reverbAuxBus
	 The	reverb	auxiliary	bus.	

float	 reverbLevel	=	1

	 The	reverb	control	value	for	the	send	to	the
reverb	aux	bus.	

float	 wallOcclusion	=	1

	 Occlusion	level	modeling	transmission	through
walls.	

int	 priority	=	0



An	AkRoom	is	an	enclosed	environment	that	can	only	communicate	to
the	outside/other	rooms	with	AkRoomPortals.
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	AkRoomPortal
An	AkRoomPortal	can	connect	two	AkRoom	components	together.	[
]

AkUnityEventHandler



Public	

ulong	 GetID	()
	 Access	the	portal's	ID.	
override	void	 HandleEvent	(GameObject	in_gameObject)
	 Opens	the	portal	on	trigger	event.	

void	 ClosePortal	(GameObject	in_gameObject)
	 Closes	the	portal	on	trigger	event.	



Public	

const	int	 MAX_ROOMS_PER_PORTAL	=	2
	 AkRoomPortals	can	only	connect	a	maximum	of	2	rooms.	
AkRoom[]	 rooms	=	new	AkRoom[MAX_ROOMS_PER_PORTAL]
const	int	 MAX_NB_TRIGGERS	=	32

	 Since	our	mask	is	a	32	bits	integer,	we	can't	have	more
than	32	triggers.	

List<	int	>	 triggerList	=	new	List<int>()	{	START_TRIGGER_ID	}
	 List	containing	the	enabled	triggers.	

bool	 useOtherObject	=	false

	

This	property	is	usefull	only	when	used	with	colliders.
When	enabled,	the	target	of	the	action	will	be	the	other
colliding	object.	When	disabled,	it	will	be	the	current
object.	



Static	Public	

static	Dictionary<	uint,	string	>	 triggerTypes	=AkTriggerBase.GetAllDerivedTypes	()

	
Will	contain	the	types	of	all	the	triggers
derived	from	AkTriggerBase	at
runtime.	



An	AkRoomPortal	can	connect	two	AkRoom	components	together.
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	AkRoomPortalObstruction
Obstructs/Occludes	the	spatial	audio	portal	of	the	current	game	object
from	the	spatial	audio	listener	if	at	least	one	object	is	between	them.	[]

AkObstructionOcclusion



Public	

LayerMask	 LayerMask	=	-1
	 Indicates	which	layers	act	as	obstructers/occluders.	

float	 refreshInterval	=	1

	 The	number	of	seconds	between	obstruction/occlusion
checks.	

float	 fadeTime	=	0.5f
	 The	number	of	seconds	for	fade	ins	and	fade	outs.	

float	 maxDistance	=	-1.0f

	
The	maximum	distance	at	which	to	perform
obstruction/occlusion.	A	negative	value	will	be	interpreted
as	inifinite	distance.	



Obstructs/Occludes	the	spatial	audio	portal	of	the	current	game	object
from	the	spatial	audio	listener	if	at	least	one	object	is	between	them.

If	no	spatial	audio	listener	has	been	registered,	there	will	be	no
obstruction.
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	AkSpatialAudioEmitter
Add	this	script	on	the	GameObject	which	represents	an	emitter	that	uses
the	Spatial	Audio	API.	[]

AkSpatialAudioBase



Public	

AK.Wwise.AuxBus	 reflectAuxBus

	 The	Auxiliary	Bus	with	a	Reflect	plug-in	Effect
applied.	

uint	 reflectionsOrder	=	1
float	 reflectionsAuxBusGain	=	1

	 The	gain	[0,	1]	applied	to	the	reflect	auxiliary	bus.
float	 reflectionMaxPathLength	=	1000

	

A	heuristic	to	stop	the	computation	of	reflections.
Should	be	no	longer	(and	possibly	shorter	for
less	CPU	usage)	than	the	maximum	attenuation
of	the	sound	emitter.	

float	 roomReverbAuxBusGain	=	1

	
Send	gain	(0.f-1.f)	that	is	applied	when	sending
to	the	aux	bus	associated	with	the	room	that	the
emitter	is	in.	



Add	this	script	on	the	GameObject	which	represents	an	emitter	that	uses
the	Spatial	Audio	API.
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	AkSpatialAudioListener
Add	this	script	on	the	game	object	that	represent	a	listener.	This	is
normally	added	to	the	Camera	object	or	the	Player	object,	but	can	be
added	to	any	game	object	when	implementing	3D	busses.
isDefaultListener	determines	whether	the	game	object	will	be
considered	a	default	listener	-	a	listener	that	automatically	listens	to	all
game	objects	that	do	not	have	listeners	attached	to	their
AkGameObjListenerList's.	[]

AkSpatialAudioBase



Add	this	script	on	the	game	object	that	represent	a	listener.	This	is
normally	added	to	the	Camera	object	or	the	Player	object,	but	can	be
added	to	any	game	object	when	implementing	3D	busses.
isDefaultListener	determines	whether	the	game	object	will	be
considered	a	default	listener	-	a	listener	that	automatically	listens	to	all
game	objects	that	do	not	have	listeners	attached	to	their
AkGameObjListenerList's.

:
Integrating	Listeners	(Note:	This	is	described	in	the	Wwise	SDK
documentation.)
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	AkState
This	will	call	AkSoundEngine.SetState()	whenever	the	selected	Unity
event	is	triggered.	For	example	this	component	could	be	set	on	a	Unity
collider	to	trigger	when	an	object	enters	it.	[]

AkUnityEventHandler



Public	

int	 groupID
	 State	Group	ID,	as	defined	in	WwiseID.cs.	

int	 valueID
	 State	Value	ID,	as	defined	in	WwiseID.cs.	
const	int	 MAX_NB_TRIGGERS	=	32

	 Since	our	mask	is	a	32	bits	integer,	we	can't	have	more
than	32	triggers.	

List<	int	>	 triggerList	=	new	List<int>()	{	START_TRIGGER_ID	}
	 List	containing	the	enabled	triggers.	

bool	 useOtherObject	=	false

	
This	property	is	usefull	only	when	used	with	colliders.
When	enabled,	the	target	of	the	action	will	be	the	other
colliding	object.	When	disabled,	it	will	be	the	current	object.



Static	Public	

static	Dictionary<	uint,	string	>	 triggerTypes	=AkTriggerBase.GetAllDerivedTypes	()

	
Will	contain	the	types	of	all	the	triggers
derived	from	AkTriggerBase	at
runtime.	



This	will	call	AkSoundEngine.SetState()	whenever	the	selected	Unity
event	is	triggered.	For	example	this	component	could	be	set	on	a	Unity
collider	to	trigger	when	an	object	enters	it.

:
Integration	Details	-	States	(Note:	This	is	described	in	the	Wwise
SDK	documentation.)
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	AkSurfaceReflector
This	component	will	convert	the	triangles	of	the	GameObject's	geometry
into	sound	reflective	surfaces.	[]



Static	Public	

static	void	 AddGeometrySet	(AK.Wwise.AcousticTexture
acousticTexture,	MeshFilter	meshFilter)

	 Sends	the	mesh	filter's	triangles	and	their	acoustic	texture
to	Spatial	Audio.	

static	void	 RemoveGeometrySet	(MeshFilter	meshFilter)

	 Remove	the	corresponding	mesh	filter's	geometry	from
Spatial	Audio.	



Public	

AK.Wwise.AcousticTexture	 AcousticTexture

	

All	triangles	of	the	component's	mesh
will	be	applied	with	this	texture.	The
texture	will	change	the	filter	parameters
of	the	sound	reflected	from	this
component.	



This	component	will	convert	the	triangles	of	the	GameObject's	geometry
into	sound	reflective	surfaces.

This	component	requires	a	Mesh	Filter	component.	The	triangles	of	the
mesh	will	be	sent	to	the	Spatial	Audio	wrapper	by	calling
SpatialAudio::AddGeometrySet().	The	triangles	will	reflect	the	sound
emitted	from	AkSpatialAudioEmitter	components.
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	AkSwitch
This	will	call	AkSoundEngine.SetSwitch()	whenever	the	selected	Unity
event	is	triggered.	For	example	this	component	could	be	set	on	a	Unity
collider	to	trigger	when	an	object	enters	it.	[]

AkUnityEventHandler



Public	

int	 groupID
	 Switch	Group	ID,	as	defined	in	WwiseID.cs.	

int	 valueID
	 Switch	Value	ID,	as	defined	in	WwiseID.cs.	
const	int	 MAX_NB_TRIGGERS	=	32

	 Since	our	mask	is	a	32	bits	integer,	we	can't	have	more
than	32	triggers.	

List<	int	>	 triggerList	=	new	List<int>()	{	START_TRIGGER_ID	}
	 List	containing	the	enabled	triggers.	

bool	 useOtherObject	=	false

	
This	property	is	usefull	only	when	used	with	colliders.
When	enabled,	the	target	of	the	action	will	be	the	other
colliding	object.	When	disabled,	it	will	be	the	current	object.



Static	Public	

static	Dictionary<	uint,	string	>	 triggerTypes	=AkTriggerBase.GetAllDerivedTypes	()

	
Will	contain	the	types	of	all	the	triggers
derived	from	AkTriggerBase	at
runtime.	



This	will	call	AkSoundEngine.SetSwitch()	whenever	the	selected	Unity
event	is	triggered.	For	example	this	component	could	be	set	on	a	Unity
collider	to	trigger	when	an	object	enters	it.

:
Integration	Details	-	Switches	(Note:	This	is	described	in	the
Wwise	SDK	documentation.)
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	AkTerminator



This	script	deals	with	termination	of	the	Wwise	audio	engine.	It	must	be
present	on	one	Game	Object	that	gets	destroyed	last	in	the	game.	It	must
be	executed	AFTER	any	other	monoBehaviors	that	use	AkSoundEngine.

:
Terminate	the	Different	Modules	of	the	Sound	Engine	(Note:
This	is	described	in	the	Wwise	SDK	documentation.)
AK::SoundEngine::Term()	(Note:	This	is	described	in	the	Wwise
SDK	documentation.)
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	AkTriggerBase
AkTriggerCollisionEnter,	AkTriggerCollisionExit,	AkTriggerDisable,
AkTriggerEnable,	AkTriggerEnter,	AkTriggerExit,	AkTriggerMouseDown,
AkTriggerMouseEnter,	AkTriggerMouseExit,		AkTriggerMouseUp



Public	

delegate	void	 Trigger	(GameObject	in_gameObject)
	 Delegate	declaration	for	all	Wwise	Triggers.	



Public	

Trigger	 triggerDelegate	=	null

	 All	components	reacting	to	the	trigger	will	be	registered	in	this
delegate.	



Base	class	for	the	generic	triggering	mechanism	for	Wwise	Integration.
All	Wwise	components	will	use	this	mechanism	to	drive	their	behavior.
Derive	from	this	class	to	add	your	own	triggering	condition,	as	decribed	in
Wwise
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AK::Wwise::BaseType
AK::Wwise::AcousticTexture
AK::Wwise::AuxBus
AK::Wwise::Bank
AK::Wwise::BaseGroupType

AK::Wwise::State
AK::Wwise::Switch

AK::Wwise::Event
AK::Wwise::RTPC
AK::Wwise::Trigger

AK::Wwise::CallbackFlags
AkAudioListener
AkBank
AkCallbackManager
AkEmitterObstructionOcclusion
AkEnvironment
AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm
AkEnvironmentPortal
AkEvent

AkAmbient
AkEventCallbackMsg
AkGameObj
AkInitializer
AkMemBankLoader
AkRoom
AkRoomPortal
AkRoomPortalObstruction
AkSpatialAudioEmitter
AkSpatialAudioListener
AkState
AkSurfaceReflector
AkSwitch
AkTerminator
AkTriggerBase
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a b c d e g h i l m p r s t u v w

-	a	-

AcousticTexture	:	AkSurfaceReflector
actionOnEventType	:	AkEvent
AddGeometrySet()	:	AkSurfaceReflector
AddListener()	:	AkGameObj
axis	:	AkEnvironmentPortal

-	b	-

bankName	:	AkBank	,	AkMemBankLoader
basePath	:	AkInitializer

-	c	-

callbackManagerBufferSize	:	AkInitializer
ClosePortal()	:	AkRoomPortal
curveInterpolation	:	AkEvent

-	d	-

decodeBank	:	AkBank
defaultPoolSize	:	AkInitializer
diffractionFlags	:	AkInitializer

-	e	-

enableActionOnEvent	:	AkEvent
engineLogging	:	AkInitializer
eventID	:	AkEvent



ExecuteAction()	:	AK::Wwise::Event

-	g	-

GetAuxSendValueForPosition()	:	AkEnvironmentPortal
GetForward()	:	AkGameObj
GetID()	:	AkRoomPortal	,	AkRoom
GetPosition()	:	AkGameObj
GetUpward()	:	AkGameObj
groupID	:	AkSwitch	,	AkState

-	h	-

HandleEvent()	:	AkBank	,	AkRoomPortal

-	i	-

info	:	AkEventCallbackMsg
isEnvironmentAware	:	AkGameObj
isLocalizedBank	:	AkMemBankLoader

-	l	-

language	:	AkInitializer
loadAsynchronous	:	AkBank
LoadLocalizedBank()	:	AkMemBankLoader
LoadNonLocalizedBank()	:	AkMemBankLoader
lowerPoolSize	:	AkInitializer

-	m	-

m_positionOffsetData	:	AkGameObj
MAX_ROOMS_PER_PORTAL	:	AkRoomPortal
maxSoundPropagationDepth	:	AkInitializer
memoryCutoffThreshold	:	AkInitializer
monitorPoolSize	:	AkInitializer
monitorQueuePoolSize	:	AkInitializer



-	p	-

Post()	:	AK::Wwise::Event
PostCallbacks()	:	AkCallbackManager
PostMIDI()	:	AK::Wwise::Event
preparePoolSize	:	AkInitializer
priority	:	AkRoom

-	r	-

reflectAuxBus	:	AkSpatialAudioEmitter
reflectionMaxPathLength	:	AkSpatialAudioEmitter
reflectionsAuxBusGain	:	AkSpatialAudioEmitter
reflectionsOrder	:	AkSpatialAudioEmitter
RemoveGeometrySet()	:	AkSurfaceReflector
RemoveListener()	:	AkGameObj
reverbAuxBus	:	AkRoom
reverbLevel	:	AkRoom
roomReverbAuxBusGain	:	AkSpatialAudioEmitter
rooms	:	AkRoomPortal

-	s	-

saveDecodedBank	:	AkBank
sender	:	AkEventCallbackMsg
SetBGMCallback()	:	AkCallbackManager
SetMonitoringCallback()	:	AkCallbackManager
soundEmitterObject	:	AkEvent
spatialAudioPoolSize	:	AkInitializer
StopMIDI()	:	AK::Wwise::Event
streamingPoolSize	:	AkInitializer

-	t	-

transitionDuration	:	AkEvent
Trigger()	:	AkTriggerBase
triggerDelegate	:	AkTriggerBase



-	u	-

UnloadBank()	:	AkBank
unloadTriggerList	:	AkBank

-	v	-

valueID	:	AkState	,	AkSwitch

-	w	-

wallOcclusion	:	AkRoom
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Licensing	(Free	&	Commercial)
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AK::Wwise::Event

ExecuteAction
Post
Post
Post
PostMIDI
PostMIDI
StopMIDI
StopMIDI

uint	AK::Wwise::Event::Post ( GameObject	 gameObject

Posts	this	Event	on	a	GameObject.

:
gameObject	 The	GameObject

:
Returns	the	playing	ID.
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AK::Wwise::Event

ExecuteAction
Post
Post
Post
PostMIDI
PostMIDI
StopMIDI
StopMIDI

void	AK::Wwise::Event::PostMIDI ( GameObject	
AkMIDIPostArray	
)

Posts	MIDI	Events	on	this	Event	associated	with	a	GameObject.

:
gameObject	 The	GameObject
array	 The	array	of	AkMIDIPost	that	are	posted.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

string	AkInitializer::basePath	=	AkSoundEngineController.s_DefaultBasePath

Path	for	the	soundbanks.	This	must	contain	one	sub	folder	per	platform,	with	the
same	as	in	the	Wwise	project.
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AkCallbackManager

PostCallbacks
SetBGMCallback
SetMonitoringCallback

static	void	AkCallbackManager::SetMonitoringCallback

Call	this	to	set	a	function	to	call	whenever	Wwise	prints	a	message	(warnings	or	errors).
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AkMemBankLoader

bankName
isLocalizedBank
LoadLocalizedBank
LoadNonLocalizedBank

void	AkMemBankLoader::LoadNonLocalizedBank

Load	a	sound	bank	from	WWW	object.
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AkCallbackManager

PostCallbacks
SetBGMCallback
SetMonitoringCallback

static	void	AkCallbackManager::SetBGMCallback

Call	this	to	set	a	iOS	callback	interruption	function.	By	default	this	callback	is	not	defined.
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A	|	B	|	C	|	E	|	R	|	S	|	T

		A		 AkEnvironmentPortal

AcousticTexture	(AK::Wwise)			

AkAmbient			 AkEventCallbackMsg

AkAudioListener			

AkBank			

AkCallbackManager			 AkMemBankLoader

AkEmitterObstructionOcclusion			

AkEnvironment			

AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm			
A	|	B	|	C	|	E	|	R	|	S	|	T
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AkCallbackManager

PostCallbacks
SetBGMCallback
SetMonitoringCallback

static	int	AkCallbackManager::PostCallbacks

This	function	dispatches	all	the	accumulated	callbacks	from	the	native
sound	engine.	It	must	be	called	regularly.	By	default	this	is	called	in
AkInitializer.cs.
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AK::Wwise::AcousticTexture	
AK::Wwise::AcousticTexture
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AK::Wwise::AuxBus	
AK::Wwise::AuxBus
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AK::Wwise::Bank	
AK::Wwise::Bank
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AK::Wwise::BaseGroupType	
AK::Wwise::BaseGroupType
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AK::Wwise::BaseType	
AK::Wwise::BaseType
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AK::Wwise::CallbackFlags	
AK::Wwise::CallbackFlags
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AK::Wwise::Event	
AK::Wwise::Event

ExecuteAction(GameObject	gameObject,
AkActionOnEventType	actionOnEventType,
int	transitionDuration,	AkCurveInterpolation
curveInterpolation)

AK::Wwise::Event [inline]

Post(GameObject	gameObject) AK::Wwise::Event [inline]
Post(GameObject	gameObject,
CallbackFlags	flags,
AkCallbackManager.EventCallback
callback,	object	cookie=null)

AK::Wwise::Event [inline]

Post(GameObject	gameObject,	uint	flags,
AkCallbackManager.EventCallback
callback,	object	cookie=null)

AK::Wwise::Event [inline]

PostMIDI(GameObject	gameObject,
AkMIDIPostArray	array) AK::Wwise::Event [inline]

PostMIDI(GameObject	gameObject,
AkMIDIPostArray	array,	int	count) AK::Wwise::Event [inline]

StopMIDI(GameObject	gameObject) AK::Wwise::Event [inline]
StopMIDI() AK::Wwise::Event [inline]
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AK::Wwise::Event

ExecuteAction
Post
Post
Post
PostMIDI
PostMIDI
StopMIDI
StopMIDI

uint	AK::Wwise::Event::Post ( GameObject	
CallbackFlags	
AkCallbackManager.EventCallback	
object	
)

Posts	this	Event	on	a	GameObject.

:
gameObject	 The	GameObject
flags	
callback	
cookie	 Optional	cookie	received	by	the	callback

:
Returns	the	playing	ID.
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AK::Wwise::Event

ExecuteAction
Post
Post
Post
PostMIDI
PostMIDI
StopMIDI
StopMIDI

uint	AK::Wwise::Event::Post ( GameObject	
uint	
AkCallbackManager.EventCallback	
object	
)

Posts	this	Event	on	a	GameObject.

:
gameObject	 The	GameObject
flags	
callback	
cookie	 Optional	cookie	received	by	the	callback

:
Returns	the	playing	ID.

Wwise	Unity	IntegrationThu	Feb	1	09:40:26	2018		 	1.6.3

http://www.doxygen.org/index.html


AK::Wwise::Event

ExecuteAction
Post
Post
Post
PostMIDI
PostMIDI
StopMIDI
StopMIDI

void	AK::Wwise::Event::ExecuteAction ( GameObject	
AkActionOnEventType	
int	
AkCurveInterpolation	
)

Executes	various	actions	on	this	event	associated	with	a	GameObject.

:
gameObject	 The	GameObject
actionOnEventType	
transitionDuration	
curveInterpolation	
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AK::Wwise::Event

ExecuteAction
Post
Post
Post
PostMIDI
PostMIDI
StopMIDI
StopMIDI

void	AK::Wwise::Event::PostMIDI ( GameObject	
AkMIDIPostArray	
int	
)

Posts	MIDI	Events	on	this	Event	associated	with	a	GameObject.

:
gameObject	 The	GameObject
array	 The	array	of	AkMIDIPost	that	are	posted.
count	 The	number	of	elements	from	the	array	that	will	be	posted.
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AK::Wwise::Event

ExecuteAction
Post
Post
Post
PostMIDI
PostMIDI
StopMIDI
StopMIDI

void	AK::Wwise::Event::StopMIDI ( GameObject	 gameObject

Stops	MIDI	Events	on	this	Event	associated	with	a	GameObject.

:
gameObject	 The	GameObject
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AK::Wwise::Event

ExecuteAction
Post
Post
Post
PostMIDI
PostMIDI
StopMIDI
StopMIDI

void	AK::Wwise::Event::StopMIDI ( 	)	 [inline]

Stops	all	MIDI	Events	on	this	Event.
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AK::Wwise::RTPC	
AK::Wwise::RTPC
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AK::Wwise::State	
AK::Wwise::State
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AK::Wwise::Switch	
AK::Wwise::Switch
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AK::Wwise::Trigger	
AK::Wwise::Trigger
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AkAmbient	
AkAmbient

actionOnEventType AkEvent
curveInterpolation AkEvent
enableActionOnEvent AkEvent
eventID AkEvent
soundEmitterObject AkEvent
transitionDuration AkEvent
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AkEvent

actionOnEventType
curveInterpolation
enableActionOnEvent
eventID
soundEmitterObject
transitionDuration

int	AkEvent::eventID	=	0

ID	of	the	Event	as	found	in	the	WwiseID.cs
file.
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AkEvent

actionOnEventType
curveInterpolation
enableActionOnEvent
eventID
soundEmitterObject
transitionDuration

GameObject	AkEvent::soundEmitterObject

Game	object	onto	which	the	Event	will	be	posted.	By
default,	when	empty,	it	is	posted	on	the	same	object
on	which	the	component	was	added.
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AkEvent

actionOnEventType
curveInterpolation
enableActionOnEvent
eventID
soundEmitterObject
transitionDuration

bool	AkEvent::enableActionOnEvent	=	false

Enables	additional	options	to	reuse	existing
events.	Use	it	to	transform	a	Play	event	into	a
Stop	event	without	having	to	define	one	in	the
Wwise	Project.
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AkEvent

actionOnEventType
curveInterpolation
enableActionOnEvent
eventID
soundEmitterObject
transitionDuration

AkActionOnEventType	AkEvent::actionOnEventType

Replacement	action.	See	AK::SoundEngine::ExecuteEventOnAction().

Wwise	Unity	IntegrationThu	Feb	1	09:40:26	2018		 	1.6.3

http://www.doxygen.org/index.html


AkEvent

actionOnEventType
curveInterpolation
enableActionOnEvent
eventID
soundEmitterObject
transitionDuration

AkCurveInterpolation	AkEvent::curveInterpolation

Fade	curve	to	use	with	the	new	Action.	See	AK::SoundEngine::ExecuteEventOnAction().
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AkEvent

actionOnEventType
curveInterpolation
enableActionOnEvent
eventID
soundEmitterObject
transitionDuration

float	AkEvent::transitionDuration	=	0.0f

Duration	of	the	fade.	See
AK::SoundEngine::ExecuteEventOnAction().
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AkSwitch

groupID
valueID

const	int	AkUnityEventHandler::MAX_NB_TRIGGERS	=	32

Since	our	mask	is	a	32	bits	integer,	we	can't	have	more	than	32	triggers.
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AkSwitch

groupID
valueID

List<int>	AkUnityEventHandler::triggerList	=	new	List<int>()	{	START_TRIGGER_ID	}

List	containing	the	enabled	triggers.
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AkSwitch

groupID
valueID

bool	AkUnityEventHandler::useOtherObject	=	false	[inherited]

This	property	is	usefull	only	when	used	with	colliders.	When
enabled,	the	target	of	the	action	will	be	the	other	colliding	object.
When	disabled,	it	will	be	the	current	object.
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AkSwitch

groupID
valueID

Dictionary<uint,	string>	AkUnityEventHandler::triggerTypes	=	AkTriggerBase.GetAllDerivedTypes	()

Will	contain	the	types	of	all	the	triggers	derived	from	AkTriggerBase
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AkAudioListener	
AkAudioListener
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AkBank	
AkBank

bankName AkBank
decodeBank AkBank
HandleEvent(GameObject	in_gameObject) AkBank [inline]

loadAsynchronous AkBank
saveDecodedBank AkBank
UnloadBank(GameObject	in_gameObject) AkBank [inline]

unloadTriggerList AkBank
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AkBank

bankName
decodeBank
HandleEvent
loadAsynchronous
saveDecodedBank
UnloadBank
unloadTriggerList

override	void	AkBank::HandleEvent ( GameObject	

Loads	the	SoundBank.
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AkBank

bankName
decodeBank
HandleEvent
loadAsynchronous
saveDecodedBank
UnloadBank
unloadTriggerList

void	AkBank::UnloadBank ( GameObject	 in_gameObject

Unloads	a	SoundBank.
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AkBank

bankName
decodeBank
HandleEvent
loadAsynchronous
saveDecodedBank
UnloadBank
unloadTriggerList

string	AkBank::bankName	=	""

Name	of	the	SoundBank,	as	specified	in	the
Wwise	project.
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AkBank

bankName
decodeBank
HandleEvent
loadAsynchronous
saveDecodedBank
UnloadBank
unloadTriggerList

bool	AkBank::loadAsynchronous	=	false

Check	this	to	load	the	SoundBank	in	the
background.	Be	careful,	if	Events	are	triggered
and	the	SoundBank	hasn't	finished	loading,
you'll	have	"Event	not	found"	errors.
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AkBank

bankName
decodeBank
HandleEvent
loadAsynchronous
saveDecodedBank
UnloadBank
unloadTriggerList

bool	AkBank::decodeBank	=	false

Decode	this	SoundBank	upon	load.
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AkBank

bankName
decodeBank
HandleEvent
loadAsynchronous
saveDecodedBank
UnloadBank
unloadTriggerList

bool	AkBank::saveDecodedBank	=	false

Save	the	decoded	SoundBank	to	disk	for	faster
loads	in	the	future.
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AkBank

bankName
decodeBank
HandleEvent
loadAsynchronous
saveDecodedBank
UnloadBank
unloadTriggerList

List<int>	AkBank::unloadTriggerList	=	new	List<int>()	{AkUnityEventHandler.DESTROY_TRIGGER_ID	}

Reserved.
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AkCallbackManager	
AkCallbackManager

PostCallbacks() AkCallbackManager [inline,
static]

SetBGMCallback(BGMCallback	in_CB,
object	in_cookie) AkCallbackManager [inline,

static]

SetMonitoringCallback(AkMonitorErrorLevel
in_Level,	MonitoringCallback	in_CB) AkCallbackManager [inline,

static]
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AkEmitterObstructionOcclusion	
AkEmitterObstructionOcclusion
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AkRoomPortalObstruction

LayerMask	AkObstructionOcclusion::LayerMask	=	-1	[inherited]

Indicates	which	layers	act	as	obstructers/occluders.
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AkRoomPortalObstruction

float	AkObstructionOcclusion::refreshInterval	=	1	[inherited]

The	number	of	seconds	between	obstruction/occlusion	checks.
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AkRoomPortalObstruction

float	AkObstructionOcclusion::fadeTime	=	0.5f	[inherited]

The	number	of	seconds	for	fade	ins	and	fade	outs.
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AkRoomPortalObstruction

float	AkObstructionOcclusion::maxDistance	=	-1.0f	[inherited]

The	maximum	distance	at	which	to	perform	obstruction/occlusion.	A
negative	value	will	be	interpreted	as	inifinite	distance.
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AkEnvironment	
AkEnvironment
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AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm

AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm
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AkEnvironmentPortal	
AkEnvironmentPortal

axis AkEnvironmentPortal
GetAuxSendValueForPosition(Vector3
in_position,	int	index) AkEnvironmentPortal [inline]
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AkEnvironmentPortal

axis
GetAuxSendValueForPosition

float	AkEnvironmentPortal::GetAuxSendValueForPosition

The	axis	used	to	find	the	contribution	of	each	environment.
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AkEnvironmentPortal

axis
GetAuxSendValueForPosition

Vector3	AkEnvironmentPortal::axis

The	array	is	already	sortet	by	position.	The	first	environment
is	on	the	negative	side	of	the	portal(opposite	to	the	direction
of	the	chosen	axis)	The	second	environment	is	on	the
positive	side	of	the	portal
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AkEvent	
AkEvent

actionOnEventType AkEvent
curveInterpolation AkEvent
enableActionOnEvent AkEvent
eventID AkEvent
soundEmitterObject AkEvent
transitionDuration AkEvent
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AkEventCallbackMsg	
AkEventCallbackMsg

info AkEventCallbackMsg
sender AkEventCallbackMsg
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AkEventCallbackMsg

info
sender

GameObject	AkEventCallbackMsg::sender

AkSoundEngine.PostEvent	callback	flags.	See	the
AkCallbackType	enumeration	for	a	list	of	all	callbacks.
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AkEventCallbackMsg

info
sender

AkCallbackInfo	AkEventCallbackMsg::info

GameObject	from	whom	the	callback	function	was	called.
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AkGameObj	
AkGameObj

AddListener(AkAudioListener	listener) AkGameObj [inline]

GetForward() AkGameObj [inline,
virtual]

GetPosition() AkGameObj [inline,
virtual]

GetUpward() AkGameObj [inline,
virtual]

isEnvironmentAware AkGameObj
m_positionOffsetData AkGameObj
RemoveListener(AkAudioListener
listener) AkGameObj [inline]
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AkGameObj

AddListener
GetForward
GetPosition
GetUpward
isEnvironmentAware
m_positionOffsetData
RemoveListener

bool	AkGameObj::AddListener ( AkAudioListener

Adds	an	AkAudioListener	to	the	container	of	listeners	listening	to	this
gameobject.

:
listener	

:
Returns	true	if	the	listener	was	not	previously	in	the	list,	false
otherwise.
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AkGameObj

AddListener
GetForward
GetPosition
GetUpward
isEnvironmentAware
m_positionOffsetData
RemoveListener

bool	AkGameObj::RemoveListener ( AkAudioListener

Removes	an	AkAudioListener	from	the	container	of	listeners	listening	to	this
gameobject.

:
listener	

:
Returns	true	if	the	listener	was	previously	in	the	list,	false	otherwise.
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AkGameObj

AddListener
GetForward
GetPosition
GetUpward
isEnvironmentAware
m_positionOffsetData
RemoveListener

virtual	Vector3	AkGameObj::GetPosition (

Gets	the	position	including	the	position	offset,	if
applyPositionOffset	is	enabled.	User	can	also	override	this	method
to	calculate	an	arbitrary	position.

:
The	position.
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AkGameObj

AddListener
GetForward
GetPosition
GetUpward
isEnvironmentAware
m_positionOffsetData
RemoveListener

virtual	Vector3	AkGameObj::GetForward (

Gets	the	orientation	forward	vector.	User	can	also	override	this
method	to	calculate	an	arbitrary	vector.

:
The	forward	vector	of	orientation.
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AkGameObj

AddListener
GetForward
GetPosition
GetUpward
isEnvironmentAware
m_positionOffsetData
RemoveListener

virtual	Vector3	AkGameObj::GetUpward (

Gets	the	orientation	upward	vector.	User	can	also	override	this
method	to	calculate	an	arbitrary	vector.

:
The	upward	vector	of	orientation.
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AkGameObj

AddListener
GetForward
GetPosition
GetUpward
isEnvironmentAware
m_positionOffsetData
RemoveListener

AkGameObjPositionOffsetData	AkGameObj::m_positionOffsetData

When	not	set	to	null,	the	position	will	be	offset	relative	to	the	Game	Object
position	by	the	Position	Offset.
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AkGameObj

AddListener
GetForward
GetPosition
GetUpward
isEnvironmentAware
m_positionOffsetData
RemoveListener

bool	AkGameObj::isEnvironmentAware	=	true

Is	this	object	affected	by	Environment	changes?
Set	to	false	if	not	affected	in	order	to	save	some
useless	calls.	Default	is	true.
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AkInitializer	
AkInitializer

basePath AkInitializer
callbackManagerBufferSize AkInitializer
defaultPoolSize AkInitializer
diffractionFlags AkInitializer
engineLogging AkInitializer
language AkInitializer
lowerPoolSize AkInitializer
maxSoundPropagationDepth AkInitializer
memoryCutoffThreshold AkInitializer
monitorPoolSize AkInitializer
monitorQueuePoolSize AkInitializer
preparePoolSize AkInitializer
spatialAudioPoolSize AkInitializer
streamingPoolSize AkInitializer
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

string	AkInitializer::language	=	AkSoundEngineController.s_Language

Language	sub-folder.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int	AkInitializer::defaultPoolSize	=	AkSoundEngineController.s_DefaultPoolSize

Default	Pool	size.	This	contains	the	meta	data	for	your	audio	project.	Default	size	is	4
MB,	but	you	should	adjust	for	your	needs.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int	AkInitializer::lowerPoolSize	=	AkSoundEngineController.s_LowerPoolSize

Lower	Pool	size.	This	contains	the	audio	processing	buffers	and	DSP	data.	Default
size	is	2	MB,	but	you	should	adjust	for	your	needs.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int	AkInitializer::streamingPoolSize

Streaming	Pool	size.	This	contains	the	streaming	buffers.	Default	size	is	1	MB,	but	you
should	adjust	for	your	needs.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int	AkInitializer::preparePoolSize	=	AkSoundEngineController.s_PreparePoolSize

Prepare	Pool	size.	This	contains	the	banks	loaded	using	PrepareBank	(Banks	decoded
on	load	use	this).	Default	size	is	0	MB,	but	you	should	adjust	for	your	needs.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

float	AkInitializer::memoryCutoffThreshold

This	setting	will	trigger	the	killing	of	sounds	when	the	memory	is	reaching	95%	of	capacity.	Lowest	priority
sounds	are	killed.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int	AkInitializer::monitorPoolSize	=	AkSoundEngineController.s_MonitorPoolSize

Monitor	Pool	size.	Size	of	the	monitoring	pool,	in	bytes.	This	parameter	is	not	used	in
Release	build.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int	AkInitializer::monitorQueuePoolSize

Monitor	Queue	Pool	size.	Size	of	the	monitoring	queue	pool,	in	bytes.	This	parameter	is	not	used	in
Release	build.

Wwise	Unity	IntegrationThu	Feb	1	09:40:26	2018		 	1.6.3

http://www.doxygen.org/index.html


AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int	AkInitializer::callbackManagerBufferSize

CallbackManager	buffer	size.	The	size	of	the	buffer	used	per-frame	to	transfer	callback	data.	Default	size	is	4
KB,	but	you	should	increase	this,	if	required.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int	AkInitializer::spatialAudioPoolSize

Spatial	Audio	Lower	Pool	size.	Default	size	is	4	MB,	but	you	should	adjust	for	your	needs.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

uint	AkInitializer::maxSoundPropagationDepth

Spatial	Audio	Max	Sound	Propagation	Depth.	Maximum	number	of	rooms	that	sound	can	propagate	through;	must
be	less	than	or	equal	to	AK_MAX_SOUND_PROPAGATION_DEPTH.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

AkDiffractionFlags	AkInitializer::diffractionFlags

Enable	or	disable	specific	diffraction	features.	See	AkDiffractionFlags.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

bool	AkInitializer::engineLogging	=	AkSoundEngineController.s_EngineLogging

Enable	Wwise	engine	logging.	Option	to	turn	on/off	the	logging	of	the	Wwise	engine.
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AkMemBankLoader	
AkMemBankLoader

bankName AkMemBankLoader
isLocalizedBank AkMemBankLoader
LoadLocalizedBank(string
in_bankFilename) AkMemBankLoader [inline]

LoadNonLocalizedBank(string
in_bankFilename) AkMemBankLoader [inline]
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AkMemBankLoader

bankName
isLocalizedBank
LoadLocalizedBank
LoadNonLocalizedBank

void	AkMemBankLoader::LoadLocalizedBank

Load	a	language-specific	bank	from	WWW	object.
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AkMemBankLoader

bankName
isLocalizedBank
LoadLocalizedBank
LoadNonLocalizedBank

string	AkMemBankLoader::bankName	=	""

Name	of	the	bank	to	load.
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AkMemBankLoader

bankName
isLocalizedBank
LoadLocalizedBank
LoadNonLocalizedBank

bool	AkMemBankLoader::isLocalizedBank

Is	the	bank	localized	(situated	in	the	language
specific	folders).
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AkRoom	
AkRoom

GetID() AkRoom [inline]

priority AkRoom
reverbAuxBus AkRoom
reverbLevel AkRoom
wallOcclusion AkRoom
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AkRoom

GetID
priority
reverbAuxBus
reverbLevel
wallOcclusion

ulong	AkRoom::GetID ( 	)	 [inline]

Access	the	room's	ID.
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AkRoom

GetID
priority
reverbAuxBus
reverbLevel
wallOcclusion

AK.Wwise.AuxBus	AkRoom::reverbAuxBus

The	reverb	auxiliary	bus.
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AkRoom

GetID
priority
reverbAuxBus
reverbLevel
wallOcclusion

float	AkRoom::reverbLevel	=	1

The	reverb	control	value	for	the	send	to	the	reverb
aux	bus.
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AkRoom

GetID
priority
reverbAuxBus
reverbLevel
wallOcclusion

float	AkRoom::wallOcclusion	=	1

Occlusion	level	modeling	transmission	through
walls.

Wwise	Unity	IntegrationThu	Feb	1	09:40:26	2018		 	1.6.3

http://www.doxygen.org/index.html


AkRoom

GetID
priority
reverbAuxBus
reverbLevel
wallOcclusion

int	AkRoom::priority	=	0

In	cases	where	a	game	object	is	in	an	area	with	two
rooms,	the	higher	priority	room	will	be	chosen	for
AK::SpatialAudio::SetGameObjectInRoom()	The
higher	the	priority	number,	the	higher	the	priority	of
a	room.
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AkRoomPortal	
AkRoomPortal

ClosePortal(GameObject	in_gameObject) AkRoomPortal [inline]
GetID() AkRoomPortal [inline]
HandleEvent(GameObject	in_gameObject) AkRoomPortal [inline]
MAX_ROOMS_PER_PORTAL AkRoomPortal
rooms AkRoomPortal
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AkRoomPortal

ClosePortal
GetID
HandleEvent
MAX_ROOMS_PER_PORTAL
rooms

ulong	AkRoomPortal::GetID ( 	)	 [inline]

Access	the	portal's	ID.
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AkRoomPortal

ClosePortal
GetID
HandleEvent
MAX_ROOMS_PER_PORTAL
rooms

override	void	AkRoomPortal::HandleEvent

Opens	the	portal	on	trigger	event.
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AkRoomPortal

ClosePortal
GetID
HandleEvent
MAX_ROOMS_PER_PORTAL
rooms

void	AkRoomPortal::ClosePortal ( GameObject	

Closes	the	portal	on	trigger	event.
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AkRoomPortal

ClosePortal
GetID
HandleEvent
MAX_ROOMS_PER_PORTAL
rooms

const	int	AkRoomPortal::MAX_ROOMS_PER_PORTAL

AkRoomPortals	can	only	connect	a	maximum	of	2	rooms.
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AkRoomPortal

ClosePortal
GetID
HandleEvent
MAX_ROOMS_PER_PORTAL
rooms

AkRoom	[]	AkRoomPortal::rooms	=	new	

The	front	and	back	rooms	connected	by	the	portal.	The	first	room	is	on	the	negative
side	of	the	portal(opposite	to	the	direction	of	the	local	Z	axis)	The	second	room	is	on
the	positive	side	of	the	portal.
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AkRoomPortalObstruction	
AkRoomPortalObstruction
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AkSpatialAudioEmitter	
AkSpatialAudioEmitter

reflectAuxBus AkSpatialAudioEmitter
reflectionMaxPathLength AkSpatialAudioEmitter
reflectionsAuxBusGain AkSpatialAudioEmitter
reflectionsOrder AkSpatialAudioEmitter
roomReverbAuxBusGain AkSpatialAudioEmitter
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AkSpatialAudioEmitter

reflectAuxBus
reflectionMaxPathLength
reflectionsAuxBusGain
reflectionsOrder
roomReverbAuxBusGain

AK.Wwise.AuxBus	AkSpatialAudioEmitter::reflectAuxBus

The	Auxiliary	Bus	with	a	Reflect	plug-in	Effect	applied.

Wwise	Unity	IntegrationThu	Feb	1	09:40:26	2018		 	1.6.3

http://www.doxygen.org/index.html


AkSpatialAudioEmitter

reflectAuxBus
reflectionMaxPathLength
reflectionsAuxBusGain
reflectionsOrder
roomReverbAuxBusGain

uint	AkSpatialAudioEmitter::reflectionsOrder

The	maximum	number	of	reflections	that	will	be
processed	for	a	sound	path	before	it	reaches	the
listener.	Reflection	processing	grows	exponentially
with	the	order	of	reflections,	so	this	number	should
be	kept	low.	Valid	range:	1-4.
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AkSpatialAudioEmitter

reflectAuxBus
reflectionMaxPathLength
reflectionsAuxBusGain
reflectionsOrder
roomReverbAuxBusGain

float	AkSpatialAudioEmitter::reflectionsAuxBusGain

The	gain	[0,	1]	applied	to	the	reflect	auxiliary	bus.
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AkSpatialAudioEmitter

reflectAuxBus
reflectionMaxPathLength
reflectionsAuxBusGain
reflectionsOrder
roomReverbAuxBusGain

float	AkSpatialAudioEmitter::reflectionMaxPathLength

A	heuristic	to	stop	the	computation	of	reflections.	Should	be	no
longer	(and	possibly	shorter	for	less	CPU	usage)	than	the
maximum	attenuation	of	the	sound	emitter.
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AkSpatialAudioEmitter

reflectAuxBus
reflectionMaxPathLength
reflectionsAuxBusGain
reflectionsOrder
roomReverbAuxBusGain

float	AkSpatialAudioEmitter::roomReverbAuxBusGain

Send	gain	(0.f-1.f)	that	is	applied	when	sending	to	the	aux	bus
associated	with	the	room	that	the	emitter	is	in.
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AkSpatialAudioListener	
AkSpatialAudioListener

Wwise	Unity	IntegrationThu	Feb	1	09:40:26	2018		 	1.6.3

http://www.doxygen.org/index.html




AkState	
AkState

groupID AkState
valueID AkState
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AkState

groupID
valueID

int	AkState::groupID

State	Group	ID,	as	defined	in	WwiseID.cs.
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AkState

groupID
valueID

int	AkState::valueID

State	Value	ID,	as	defined	in	WwiseID.cs.
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AkSurfaceReflector	
AkSurfaceReflector

AcousticTexture AkSurfaceReflector
AddGeometrySet(AK.Wwise.AcousticTexture
acousticTexture,	MeshFilter	meshFilter) AkSurfaceReflector [inline,

static]

RemoveGeometrySet(MeshFilter	meshFilter) AkSurfaceReflector [inline,
static]
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AkSurfaceReflector

AcousticTexture
AddGeometrySet
RemoveGeometrySet

static	void	AkSurfaceReflector::AddGeometrySet

Sends	the	mesh	filter's	triangles	and	their	acoustic	texture	to	Spatial	Audio.

:
acousticTexture	
meshFilter	
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AkSurfaceReflector

AcousticTexture
AddGeometrySet
RemoveGeometrySet

static	void	AkSurfaceReflector::RemoveGeometrySet

Remove	the	corresponding	mesh	filter's	geometry	from	Spatial	Audio.

:
meshFilter	
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AkSurfaceReflector

AcousticTexture
AddGeometrySet
RemoveGeometrySet

AK.Wwise.AcousticTexture	AkSurfaceReflector::AcousticTexture

All	triangles	of	the	component's	mesh	will	be	applied	with	this	texture.
The	texture	will	change	the	filter	parameters	of	the	sound	reflected
from	this	component.
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AkSwitch	
AkSwitch

groupID AkSwitch
valueID AkSwitch
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AkSwitch

groupID
valueID

int	AkSwitch::groupID

Switch	Group	ID,	as	defined	in	WwiseID.cs.
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AkSwitch

groupID
valueID

int	AkSwitch::valueID

Switch	Value	ID,	as	defined	in	WwiseID.cs.
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AkTerminator	
AkTerminator
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AkTriggerBase	
AkTriggerBase

Trigger(GameObject	in_gameObject) AkTriggerBase
triggerDelegate AkTriggerBase
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AkTriggerBase

Trigger
triggerDelegate

delegate	void	AkTriggerBase::Trigger ( GameObject	

Delegate	declaration	for	all	Wwise	Triggers.

:

in_gameObject	
in_gameObject	is	used	to	pass	"Collidee"	objects
when	Colliders	are	used.	Some	components	have	the
option	"Use	other	object",	this	is	the	object	they'll	use.
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AkTriggerBase

Trigger
triggerDelegate

Trigger	AkTriggerBase::triggerDelegate	=	null

All	components	reacting	to	the	trigger	will	be
registered	in	this	delegate.
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AddGeometrySet()	:	AkSurfaceReflector
AddListener()	:	AkGameObj
ClosePortal()	:	AkRoomPortal
ExecuteAction()	:	AK::Wwise::Event
GetAuxSendValueForPosition()	:	AkEnvironmentPortal
GetForward()	:	AkGameObj
GetID()	:	AkRoomPortal	,	AkRoom
GetPosition()	:	AkGameObj
GetUpward()	:	AkGameObj
HandleEvent()	:	AkBank	,	AkRoomPortal
LoadLocalizedBank()	:	AkMemBankLoader
LoadNonLocalizedBank()	:	AkMemBankLoader
Post()	:	AK::Wwise::Event
PostCallbacks()	:	AkCallbackManager
PostMIDI()	:	AK::Wwise::Event
RemoveGeometrySet()	:	AkSurfaceReflector
RemoveListener()	:	AkGameObj
SetBGMCallback()	:	AkCallbackManager
SetMonitoringCallback()	:	AkCallbackManager
StopMIDI()	:	AK::Wwise::Event
Trigger()	:	AkTriggerBase
UnloadBank()	:	AkBank
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a b c d e g i l m p r s t u v w

	

-	a	-

AcousticTexture	:	AkSurfaceReflector
actionOnEventType	:	AkEvent
axis	:	AkEnvironmentPortal

-	b	-

bankName	:	AkBank	,	AkMemBankLoader
basePath	:	AkInitializer

-	c	-

callbackManagerBufferSize	:	AkInitializer
curveInterpolation	:	AkEvent

-	d	-

decodeBank	:	AkBank
defaultPoolSize	:	AkInitializer
diffractionFlags	:	AkInitializer

-	e	-

enableActionOnEvent	:	AkEvent
engineLogging	:	AkInitializer
eventID	:	AkEvent

-	g	-



groupID	:	AkState	,	AkSwitch

-	i	-

info	:	AkEventCallbackMsg
isEnvironmentAware	:	AkGameObj
isLocalizedBank	:	AkMemBankLoader

-	l	-

language	:	AkInitializer
loadAsynchronous	:	AkBank
lowerPoolSize	:	AkInitializer

-	m	-

m_positionOffsetData	:	AkGameObj
MAX_ROOMS_PER_PORTAL	:	AkRoomPortal
maxSoundPropagationDepth	:	AkInitializer
memoryCutoffThreshold	:	AkInitializer
monitorPoolSize	:	AkInitializer
monitorQueuePoolSize	:	AkInitializer

-	p	-

preparePoolSize	:	AkInitializer
priority	:	AkRoom

-	r	-

reflectAuxBus	:	AkSpatialAudioEmitter
reflectionMaxPathLength	:	AkSpatialAudioEmitter
reflectionsAuxBusGain	:	AkSpatialAudioEmitter
reflectionsOrder	:	AkSpatialAudioEmitter
reverbAuxBus	:	AkRoom
reverbLevel	:	AkRoom
roomReverbAuxBusGain	:	AkSpatialAudioEmitter
rooms	:	AkRoomPortal



-	s	-

saveDecodedBank	:	AkBank
sender	:	AkEventCallbackMsg
soundEmitterObject	:	AkEvent
spatialAudioPoolSize	:	AkInitializer
streamingPoolSize	:	AkInitializer

-	t	-

transitionDuration	:	AkEvent
triggerDelegate	:	AkTriggerBase

-	u	-

unloadTriggerList	:	AkBank

-	v	-

valueID	:	AkState	,	AkSwitch

-	w	-

wallOcclusion	:	AkRoom
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